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Notices 
© Agilent Technologies, Inc. 1998, 
1999, 2000, 2002, 2010 and 2011 

No part of this manual may be 
reproduced in any form or by any 
means (including electronic storage 
and retrieval or translation into a 
foreign language) without prior 
agreement and written consent from 
Agilent Technologies, Inc. as governed 
by United States and international 
copyright laws. 

Manual Part Number 
8510162500 

Edition 
Ninth edition, September 2011 

Printed in Australia 

Agilent Technologies, Inc. 

Errata Statement 
NOTICE: This document contains 
references to Varian. Please note that 
Varian, Inc. is now part of Agilent 
Technologies. For more information, 
go to www.agilent.com/chem. 

 

Warranty 
The material contained in this 
document is provided “as is,” and is 
subject to being changed, without 
notice, in future editions. Further, to 
the maximum extent permitted by 
applicable law, Agilent disclaims all 
warranties, either express or implied, 
with regard to this manual and any 
information contained herein, 
including but not limited to the 
implied warranties of merchantability 
and fitness for a particular purpose. 
Agilent shall not be liable for errors 
or for incidental or consequential 
damages in connection with the 
furnishing, use, or performance of 
this document or of any information 
contained herein. Should Agilent and 
the user have a separate written 
agreement with warranty terms 
covering the material in this 
document that conflict with these 
terms, the warranty terms in the 
separate agreement shall control. 

Technology Licenses 
The hardware and/or software 
described in this document are 
furnished under a license and may be 
used or copied only in accordance 
with the terms of such license. 

Restricted Rights Legend 
If software is for use in the 
performance of a U.S. Government 
prime contract or subcontract, 
Software is delivered and licensed as 
“Commercial computer software” as 
defined in DFAR 252.227-7014 (June 
1995), or as a “commercial item” as 
defined in FAR 2.101(a) or as 
“Restricted computer software” as 
defined in FAR 52.227-19 (June 1987) 
or any equivalent agency regulation or 

contract clause. Use, duplication or 
disclosure of Software is subject to 
Agilent Technologies’ standard 
commercial license terms, and non-
DOD Departments and Agencies of the 
U.S. Government will receive no 
greater than Restricted Rights as 
defined in FAR 52.227-19(c)(1-2) (June 
1987). U.S. Government users will 
receive no greater than Limited Rights 
as defined in FAR 52.227-14 (June 
1987) or DFAR 252.227-7015 (b)(2) 
(November 1995), as applicable in any 
technical data. 

Safety Notices 

A CAUTION notice denotes a hazard. 
It calls attention to an operating 
procedure, practice, or the like that, if 
not correctly performed or adhered to, 
could result in damage to the product 
or loss of important data. Do not 
proceed beyond a CAUTION notice 
until the indicated conditions are fully 
understood and met. 

A WARNING notice denotes a 
hazard. It calls attention to an 
operating procedure, practice, or the 
like that, if not correctly performed or 
adhered to, could result in personal 
injury or death. Do not proceed 
beyond a WARNING notice until the 
indicated conditions are fully 
understood and met. 

WARNING 

CAUTION 
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Applications 
Agilent Cary 100/300/4000/5000/6000i instruments run using the 
easy-to-use Agilent Cary WinUV software. The Cary WinUV software 
consists of various applications, depending on the Cary package 
ordered (refer to Table 1). A brief description of each application is 
provided in Table 2. For detailed information about each application, 
refer to Chapter 3. 

Table 1. Applications included with each Cary WinUV software package 

Package Applications 

Analysis ADL Shell, Advanced Reads, Align, Concentration, GLP Administration, Kinetics, 
Scan, Scanning Kinetics, Simple Reads, System Information, Validate 

Bio ADL Shell, Advanced Reads, Align, Concentration, Enzyme Kinetics, GLP 
Administration, Kinetics, RNA-DNA Estimation, Scan, Scanning Kinetics, Simple 
Reads, System Information, Thermal, Validate 

Color Color 
Pharma ADL Shell, Advanced Reads, Align, Concentration, Enzyme Kinetics, GLP 

Administration (not for CFR systems), Kinetics, RNA-DNA Estimation, Scan, 
Scanning Kinetics, Simple Reads, System Information, Thermal, Validate, 
Spectroscopy Configuration Manager (administrator use only), Varian 
Spectroscopy Database Administrator (administrator use only) 
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Table 2. Descriptions of each Cary WinUV software application 

Application Description Page 

ADL Shell A pre-defined template for writing ADL programs. 22 
Advanced Reads For collecting absorbance readings for multiple samples at single and 

multi wavelengths (up to 6). 
22 

Align For aligning various instrument lamps and accessories. 22 
Color For calculating color coordinates, determining color difference and 

graphically displaying both. 
23 

Concentration For quantitative analysis. 24 
Enzyme Kinetics For determining various parameters of enzyme activity at single and multi 

wavelengths (up to 6). 
24 

GLP Administration For restricting operator access, password-protecting each application. 24 
Kinetics For performing kinetics determinations at single and multi wavelengths 

(up to 6). 
25 

RNA-DNA Estimation For collecting absorbance readings of nucleic acids. 25 
Scan For running and view data collections. 26 
Scanning Kinetics For performing kinetics determinations for a wavelength range. 26 
Simple Reads For taking absorbance readings at a single and multi wavelength (up to 

6). 
26 

Spectroscopy 
Configuration Manager 

For administrators to set 21 CFR Part 11 security and access privileges in 
Pharma software. 

26 

System Information For recording your company and instrument details for use in reports, 
and so on. 

27 

Thermal For temperature-based multicell measurements, typically DNA melts at 
single and multi wavelengths (up to 6). 

28 

Validate For testing your instrument to ensure that it is working correctly. 28 
Varian Spectroscopy 
Database Administrator 

Provides a database environment for storing and maintaining your data. 28 
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User documentation 
You have been provided with the following documentation to help set 
up and operate your Cary system: 

 A hardware manual, with safety practices and hazards 
information, instructions for installing and maintaining the 
components of the Cary and troubleshooting information. 

 This software manual, with instructions for installing the Cary 
WinUV software, an overview of the software detailed ‘How To’ 
procedures and software-related troubleshooting information. 

 Extensive Help (provided with the Cary WinUV software) 
containing context-sensitive Help, step-by-step instructions for 
frequently performed analyses and instructions for using any 
accessories you ordered. Refer to ‘Using the Help’ on Page 20. 

Conventions 
The following conventions are used throughout procedures in the 
documentation: 

 Menus, menu items, buttons and check boxes have been typed in 
bold. For example, ‘click OK’ and ‘From the Edit menu, choose 
Copy’.  

 ALL CAPITALS indicate keyboard commands. For example, 
‘Press ENTER’ and ‘Press SHIFT+F3’. 

A Note is used to give advice or information. 

A Tip is used to give practical hints to help you achieve the best 
possible performance from your instrument.  
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This chapter assumes you have already set up the Cary instrument 
and computer, including installing the instrument interface card in 
the computer (if you supplied your own computer) and connecting 
the instrument and/or computer to the power supply as described in 
the appropriate Cary hardware documentation. 

Computer requirements 
The Cary 100/300/4000/5000/6000i UV-Vis-NIR spectrophotometers 
were evaluated under Agilent’s ISO9001 procedures using Cary 
WinUV software and a desktop computer. We strongly recommend a 
computer configuration that matches the system that was used 
during evaluations: 

 HP Z210 SFF Workstation 

 HP Single Unit (SFF) Packaging 

 HP Energy Star 5.0 Enabled Configuration 

 HP Z210 SFF 240W 90% Efficient Chassis 

 MS Windows 7 Professional 32-Bit OS 

 Intel Xeon E3-1225 3.1 6M 4C 95W GT2 CPU 

 HP 4GB (2x2GB) DDR3-1333 nECC RAM 
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 HP 250GB SATA 6Gb/s 7200 1st HDD 

 Intel HD Graphics P3000 

 HP No Keyboard Option 

 HP USB Optical Scroll Mouse 

 HP 16X DVD+-RW SuperMulti SATA 1st Drive 

 HP 3-3-3 Warranty SFF 

 HP Serial Port Adapter Kit 

 HP Z210 Localization Kit 

 SFF SATA HDD2 Cable 

OR 

 HP Compaq 8000 Elite Small Form Factor Desktop 

 Intel Core 2 Duo E8500 Processor 

 2 GB PC3-10600 Memory (2x1 GB) 

 250 GB SATA 3.5 1st Hard Drive 

 Integrated Intel Graphics Media Accelerator 4500 

 Integrated Intel 82567LM Gigabit 

 16x SATA SuperMulti LightScribe DVD+/-RW 

 Realtek ALC261 High Definition Audio Codec (all ports are 
stereo) 

 Windows 7 Pro 32-bit 

 One comm port if using the Agilent SPS 3 Sample Preparation 
System in conjunction with the Internal Routine Sampler 

 Two comm ports if using the Agilent SPS 3 Sample Preparation 
System in conjunction with the External Sipper accessory 

 
  



Installation 

Cary WinUV Software Manual 13 

If upgrading from previous versions of Cary WinUV software, the 
computer configuration will need to include: 

 IBM compatible 

 Intel® Pentium® IV processor (or later) 

 At least 1GB RAM 

 At least 10 GB free space on hard drive 

 Video card supporting 800 x 600 pixel resolution, high color (16 
bit) mode (or better) 

 Super VGA screen (or better) 

 20 x CD drive 

 16 bit sound card 

 Windows® 101 key keyboard 

 Microsoft® or compatible mouse 

 Windows XP with Service Pack 3 

 RS232 serial port 

 One comm port if using the Agilent SPS 3 Sample Preparation 
System in conjunction with the Internal Routine Sampler  

 Two comm ports if using the Agilent SPS 3 Sample Preparation 
System in conjunction with the External Sipper accessory 

 Microsoft Internet Explorer version 6* or later 

PCI slot for IEEE * The Cary WinUV software uses functionality 
provided by Microsoft Internet Explorer version 6.0. You do not need 
to use this as your Web browser. If your company rules prevent the 
installation of Internet Explorer version 6, you can use another 
browser, with some loss in functionality. 
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Preparation 
Before installing the Cary WinUV software, ensure that you have: 

Preparation requirement Reference 

Installed Microsoft Windows 7 32-bit operating system 
with Service Pack 1 or Windows XP Service Pack 3 and 
checked that all devices, for example, sound card and CD 
drive, are working. 

Windows operating system documentation. 

Installed Windows Internet Explorer version 6 or later. Documentation supplied with Internet Explorer. 
Set the monitor screen resolution to at least 800 x 600 
pixels and the color quality to at least High Quality. 

Windows operating system documentation. 

Logged on as an Administrator. Windows operating system documentation. 
Read the Late Breaking News. Any Late Breaking News documents delivered 

with the Cary WinUV software. 
 

NOTE The Cary WinUV software will read Cary OS/2 and DOS data files. However, if 
you are upgrading to version 4.20 from Cary OS/2 or DOS, contact your local 
Agilent office, as a service call will be required. 

 

NOTE If you are installing 21 CFR Part 11 software, refer to the Cary WinUV Pharma 
Software Installation Instructions for 21 CFR Part 11 Environments. 

21 CFR Part 11 software installation involves an administrator using the Agilent 
Spectroscopy Configuration Manager (SCM) to set up access privileges, and so 
on. In addition, SCM uses the Varian Spectroscopy Database Administration 
(VSDA) program for storing files. Refer to the SCM and VSDA Help for 
information about setting up 21 CFR Part 11 systems. 
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New computer 
To install the Cary WinUV software on a new computer: 

1 Log on to the instrument computer with Administrator 
privileges. 

2 Insert the application software disk, select the preferred 
language and click OK. 

 If using Windows 7 operating system, a User Account Control 
dialog box will appear, click Yes for ‘Do you want to allow the 
following program to make changes to this computer?’. 

NOTE If no installation screen appears, run ‘CaryWinUVBioSetup.exe’ from the CD 
directory. 

3 Follow the prompts on the screen until the ‘Select Destination 
Location’ window appears. Confirm the directory in which you 
would like to install the application. Alternatively, click Browse 
to choose a different location. Click Next. 

NOTE Agilent strongly recommends that the Varian\Cary WinUV folder and 
applications be installed in the recommended C:\Program Files directory. 

4 The ‘Folder Does Not Exist’ dialog box may appear. Click Yes to 
create the folder. 

5 Follow the prompts on the screen until the ‘Ready to Install’ 
window appears. Click Install. 

NOTE During the installation of the .Net Framework and GPIB driver, the computer may 
appear frozen and the ‘Cancel’ button is unavailable. This is correct. The 
installation can take 3 to 5 minutes. Do not try to exit the installation during this 
time. 

6 If prompted to complete installation of Cary WinUV by restarting 
your computer, select No, I will restart the computer later. Click 
Finish. 

7 Remove the application disk from the CD drive. 
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8 Insert the disk labeled Help.  

 If using Windows 7 operating system, a User Account Control 
dialog box will appear, click Yes for ‘Do you want to allow the 
following program to make changes to this computer?’. 

NOTE If no installation screen appears, run ‘Setup.exe’ from the CD directory. 

9 A list of Help files to be installed will be displayed. Click OK. 

10 Follow the instructions on the screen to install the Help.  

11 When the status indicates ‘Finished’, click Close. 

12 Remove the Help disk from the CD drive. 

NOTE At the end of the application software installation, you will need to turn off the 
computer in order to install the computer-instrument interface card or connect 
the computer-instrument interface converter and to complete the automatic 
detection and installation of the driver for the instrument interface card. Refer to 
the Cary 100/300/4000/5000/6000i Spectrophotometers Hardware Manual. 

13 Select the System Information application from the Cary WinUV 
folder on the Windows desktop. Enter the company details, 
instrument type and serial number. Click OK. 

14 Restart the computer to complete the installation of the 
instrument interface card. 
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Upgrade 

NOTE If you are upgrading 21 CFR Part 11 software, refer to the Cary WinUV Pharma 
Software Installation Instructions for 21 CFR Part 11 Environments. 

To upgrade the Cary WinUV software: 

1 Log on to the instrument computer with Administrator 
privileges. 

2 When upgrading Cary WinUV version 3.1 or earlier, proceed to 
Step 3. When upgrading Cary WinUV version 4.10 (build 464) or 
Cary WinUV version 4.10 (build 467), proceed to Step 4. 

3 Right-click on the System Information icon on the Windows 
toolbar, and select Shut Down System Information. 

4 Click Start > Settings > Control Panel > Add/Remove 
Programs. 

 If using Cary WinUV version 3.1 or earlier, click NI-
488.2.1.60 and then click Change/Remove and follow the 
prompts. When prompted, click Yes to remove all unused 
components. 

 If using Cary WinUV version 4.10 (build 464) or Cary WinUV 
version 4.10 (build 467), click National Instruments 
Software and then click Change/Remove and follow the 
prompts. When prompted, click Yes to remove all unused 
components. 

5 Insert the application software disk, select the preferred 
language and click OK. 

 If using Windows 7 operating system, a User Account Control 
dialog box will appear, click Yes for ‘Do you want to allow the 
following program to make changes to this computer?’ to 
install the application software. 
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NOTE If no installation screen appears, run ‘CaryWinUVBioSetup.exe’ from the CD 
directory. 

6 Follow the prompts on the screen until the ‘Select Destination 
Location’ window appears. Confirm the directory in which you 
originally installed the application software. If required, click 
Browse to navigate to the correct location. Click Next. 

NOTE Agilent strongly recommends the Varian\Cary WinUV folder and applications are 
installed in the recommended C:\Program Files directory. 

7 The ‘Folder Exists’ dialog box will be displayed. Click Yes. 

8 Follow the prompts on the screen until the ‘Ready to Install’ 
window appears. Click Install. 

NOTE During installation of the Microsoft .Net Framework and GPIB driver, the 
computer may appear frozen and the ‘Cancel’ button is unavailable. This is 
correct. The installation can take 3 to 5 minutes. Do not try to exit the installation 
during this time. 

9 If prompted to complete installation of Cary WinUV by restarting 
your computer, select No, I will restart the computer later. Click 
Finish.  

10 Remove the application disk from the CD drive. 

11 Insert the disk labeled Help.  

 If using Windows 7 operating system, a User Account Control 
dialog box will appear, click Yes for ‘Do you want to allow 
the following program to make changes to this computer?’. 

NOTE If no installation screen appears, run ‘Setup.exe’ from the CD directory. 

12 A list of Help files to be installed will be displayed. Click OK. 

13 Follow the instructions displayed on the screen to install the 
Help.  
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14 When the status indicates ‘Finished’, click Close. 

15 Remove the Help disk from the CD drive. 

16 Select the System Information application from the Cary WinUV 
folder on the Windows desktop; enter the Company details, 
Instrument type and Instrument Serial number. Click OK. 

17 Restart the computer to complete the installation. 

Starting the software 
To start the Cary WinUV software: 

1 Click the Windows Start button then (All) Programs, Agilent 
and Cary WinUV. Alternatively, double-click the Cary WinUV 
folder on the desktop. 

2 Select the desired application. Refer to Chapter 3 for information 
about the available applications. 

3 The first time the Cary WinUV software is open a Software 
Registration dialog will appear. Click Next. 

NOTE Ensure the software registration is completed by the user of the Agilent Cary UV-
Vis-NIR spectrophotometer. For further information refer to the Software 
Registration Help. 

4 Complete all the fields on the ‘Customer Details’ page. Click 
Next. 

NOTE The Product Key is found on the cover of the Agilent Cary WinUV software CD 
case which was delivered with the instrument. 

5 Complete all the fields on the ‘Product Details’ page. Click Next. 

6 Complete all the fields on the ‘Work Environment Details’ page. 
Click Register. 

7 A dialog appears stating ‘Your Agilent Software Registration has 
been successful’. 
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NOTE If your computer is not connected to the internet, refer to the Software 
Registration Help for further information. 

8 The application will now open, and you can collect your data. 

TIP To familiarize yourself with the Cary WinUV software, browse the Help after 
installing the software. See ‘Using the Help’ on Page 20. 
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This chapter provides a brief introduction to the Cary WinUV 
software and the individual applications to help you familiarize 
yourself with its use. For more detailed information about the 
applications and their settings, refer to the extensive Help (see Page 
20 for information about using the Help). 
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ADL Shell 
The Applications Development Language (ADL) is a built-in 
spectroscopy language supplied with the Cary WinUV software. The 
ADL Shell gives you a pre-defined template for writing ADL 
programs. Rather than needing to write the code for basic functions 
such as graphing and filing, the ADL Shell has a number of these 
commands already implemented. In other words, you do not have to 
design your own interface — you can use the ADL Shell to provide the 
basic functionality and build on that. 

Advanced Reads 
The Advanced Reads application can be used to read multiple 
samples in a single run at a single or multi wavelength (up to 6). You 
can use various accessories to take multiple sample solution and 
aliquot readings in absorbance, percent transmittance, Abs*F or 
percent reflectance mode, and find the mean. 

Align 
The Align application is used to align the lamp(s) in the instrument 
and various accessories. It enables you to set instrument parameters 
such as the beam mode and wavelength. It also allows you to keep 
track of operating hours by lamp type. 

The ‘Lamps’ page of the Alignment window allows you to monitor the 
energy of the lamp(s). Instrument parameters can be changed on the 
‘Cary’ page. 

Align can also be used to configure the Series 1 and Series II 6 x 6 
and 8 x 6 cell changer (Cary 100/300), the cell changer for microcells 
(Cary 100/300/4000/5000/6000i), and the Series I and II Rear Beam 
Attenuator (Cary 100/300/4000/5000/6000i). 
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Color 
The Color application is used to measure and calculate the 
transmitted or reflected color of samples. The following extensive 
color calculations are supported:  

 Tristimulus  

 Chromaticity  

 CIE Lab  

 CIE LUV  

 Hunter Lab  

 Whiteness  

 Yellowness (ASTM E 313-00)  

 Tint (ASTM E 313-00) 

 Gardner Color (ASTM D 6166-97 and DIN EN1557) 

 Haze (ASTM D1003-61)  

 Choice of 21 illuminants, including 2 user-specified illuminants  

 Choice of 6 observers, including 2 user-specified observers  

 Calculation interval of 1, 5 or 10 nm  

 Thickness correction to calculate the color of the same sample in 
varying thicknesses, rather than having to measure the samples 

 Graphical display of color spaces 

 Color difference calculations — Delta E, FMC-2, CMC and BFD  

 Color matching tolerance circle using DE Lab 
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Concentration 
The Concentration application is used to calibrate the system for 
quantitative analysis. You can select from several fit types for your 
calibration: linear, direct linear and quadratic. Based on the fit type, 
the Concentration application will calculate the coefficients of the fit 
equation and the correlation coefficient. Alternatively, you can define 
your own equation for the calibration. 

Enzyme Kinetics 
The Enzyme Kinetics application uses Michaelis-Menten principles to 
calculate the maximum rate (Vmax) and substrate concentration that 
gives half the maximum rate (Km) of enzyme-catalyzed reactions.  

Accurately obtaining Vmax and Km, requires you to perform numerous 
Enzyme Kinetics runs at different substrate or inhibitor 
concentrations to create a series of absorbance versus time curves. 
The software determines the initial velocity (V0) of each curve, and 
then you enter the substrate and inhibitor concentrations for each 
cuvette. 

The software uses the V0, [S] and [I] values to plot traces 
representing absorbance versus time curves with a common [S] or 
[I]. It is from these graphs that the software determines Vmax and Km. 

Enzyme kinetics measurements can be performed at single or multi 
wavelengths (up to 6). 

GLP Administration 
The GLP Administration application is used to protect the system 
from unauthorized use, enabling application-specific privileges to be 
turned on or off by the system administrator. 

If this application is operational, users will need to be registered, 
have a user name and a valid password before they can access the 
various privileges. 
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Kinetics 
The Kinetics application is used to obtain absorbance versus time 
data to enable you to determine the rate of reaction. Kinetics 
measurements can be performed at single or multi wavelengths (up 
to 6). 

The Kinetics application allows: 

 Calculation of Zero Order, First Order and Second Order reaction 
rates from absorbance versus time data. 

 Entry of activity factors for multiple cells. 

 Overlay of the best-fit line on raw data. 

 Auto or manual estimates for the first order and second order 
Marquardt fitting. 

RNA-DNA Estimation 
The RNA-DNA Estimation application is used to calculate the 
following parameters, used in determining the amount, type and 
purity of nucleic acid samples:  

 Absorbance of samples at selected wavelengths. 

 A(260)/A(280) ratios with or without background correction at 
320 nm. 

 Absorbance ratios at your own nominated wavelengths with or 
without background correction. 

 Average ratio values for replicate samples. 

 Protein and nucleic acid concentrations using Warburg Christian 
coefficients. 

 260 nm Factor Parameters, A(260) * F. 
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Scan 
The Scan application enables you to set up and run wavelength 
scans, with the collected scans displayed in the ‘Scan’ window. 

Scanning Kinetics 
The Scanning Kinetics application allows you to perform cyclic scans 
across a wavelength or wavenumber range. From the resultant 
absorbance versus wavelength data, an absorbance versus time 
(kinetics) curve can be obtained for any wavelength in the range. The 
kinetics curves can then be used to calculate Zero Order, First Order 
and Second Order reaction rates. 

You can choose an automatic or manual estimate for the First Order 
and Second Order Marquardt fitting. 

This application also enables you to correct samples for a baseline 
during the scan. You can choose a 100%T baseline, or you can select 
from other baseline options such as a zero baseline correction that 
will apply both a 100%T and a 0%T baseline correction to your sample 
scans. 

Simple Reads 
The Simple Reads application is used to perform quick absorbance 
readings of samples at single wavelengths. To take a reading, click 
‘Zero’ to zero the instrument and then click ‘Read’. 

Simple Reads measurements can be performed at single or multi 
wavelengths (up to 6). 

Spectroscopy Configuration Manager 
The Spectroscopy Configuration Manager (SCM) provides the system 
administrator with a tool to manage your 21 CFR Part 11 
environment. SCM provides the means to create, configure and 
maintain data in relation to system security, user management and 
data paths. 
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The Privileges and Profiles software controls which 
applications/functions may be run by a particular user. It also 
establishes the level of authority a user may have with regard to 
signatures and accessing certain parts of an application 

Agilent uses the SCM for security and permission rights. These 
security functions provide: 

 Access controls and authority checks via the use of user 
identification codes and passwords.  

 Electronic record security via the use of databases.  

 Time and date stamped audit trails.  

The use of user identification codes and passwords enables control 
over who can log on to the system and who can perform particular 
functions within the Agilent application software. It also provides the 
mechanism to allow electronic signing of electronic records. The use 
of databases coupled with SCM, prevents all unauthorized users from 
changing or deleting files. The SCM event logs augment the audit 
trails resident in the application software. The SCM administrator 
must set up the required users. It is important that a number of 
simple requirements are followed when this is done to ensure that 
compliance with the 21 CFR Part 11 rule is maintained. 

System Information 
The System Information application allows you to enter company 
and instrument information, and specify headers, footers and bitmap 
or icon files to be used in reports (for example, your company logo). 

System Information also allows you to specify the default settings for 
the ‘Hint’ text, such as the Hint Pause (the length of the delay before 
the hint appears when the pointer is moved over a control) and Hint 
Hide Pause (the time the hint stays visible for if the pointer is not 
moved off the control). These settings will be used by the other Cary 
WinUV applications. 
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Thermal  
The Thermal application is used to perform thermal DNA analysis, 
enabling you to calculate Tm using the various thermoelectric Cary 
accessories. Once the data is collected, you can choose to calculate 
the Tm value by either the derivative or hyperchromicity methods. 

Thermal measurements can be performed at single or multi 
wavelengths (up to 6). 

Validate 
The Validate application enables you to carry out a number of 
performance tests to verify that the system is performing according 
to specification. Included are the validation tests needed to satisfy 
the requirements of the British Pharmacopoeia, European 
Pharmacopoeia, US Pharmacopoeia and Therapeutic Goods 
Association of Australia. 

An optional Validation package is also available from Agilent, 
providing detailed information on the functional specification and 
development process of the Cary system. It also contains detailed 
DQ/IQ/OQ documentation to assist your initial and on-going 
validation activities. 

Varian Spectroscopy Database Administrator 
The Varian Spectroscopy Database Administrator (VSDA) is designed 
for system administrators to set up and maintain the databases that 
are used by the application software to store data. VSDA uses 
Microsoft SQL Server 2005 for database operations. 

Companies can use VSDA together with the Agilent Spectroscopy 
Configuration Manager (SCM), the application software and their 
own Standard Operating Practices to form a 21 CFR Part 11 capable 
environment for controlling their Agilent instruments. 

VSDA allows the data collected by Agilent instruments to be stored 
locally (on the same computer as the application software), or 
remotely in a Client/Server arrangement. 
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Configuration must be performed by the system administrator, or a 
person with administration rights to run VSDA. 

File name extensions 
The various Cary WinUV software files, such as method files, report 
files and graphic files are saved with a three-letter file name 
extension that represents the type of file, and the application that 
created the file. 

The file name extensions for each file type are: 

File type File name extension 
Methods .m** 
Data .d** 
Report .r** 
Graph Template .g** 
Settings .s** 
Baseline .c** 
Batch .b** 
ASCII .csv 
Rich Text Format .rtf 
Cary OS/2 .dat 
Cary DOS data. 
Grams .spc 
ADL .adl 

where ** equals the Cary WinUV application code, used to distinguish 
between different applications.  
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The application codes are: 

Application File name extension
Advanced Reads .*ab 
Color .*cl 
Concentration .*cn 
Enzyme Kinetics .*ek 
Fabric Protection .*fp 
Kinetics .*kn 
RNA-DNA .*dn 
Scan .*sw 
Scanning Kinetics .*sk 
Simple Reads .*sr 
Sunglasses .*sg 
Thermal .*tm 
Validate .*vo 

For example, a method file from the Concentration application would 
have the file name extension ‘*.mcn’. 
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Interface 
A typical Cary WinUV software screen consists of a Menu line (‘A’ in 
Figure 1), Instrument buttons (B), Command buttons (C), Toolbar 
(D), Graph area (E), Report area (F) and Status line (G). 

 

 
Figure 1. A typical Cary WinUV software screen  
A. Menu line  B. Instrument buttons C. Command buttons D. Toolbar 
E. Graph area  F. Report area  G. Status line 

Hint text 
You can obtain ‘Hint text’ for a particular control or field by 
positioning the pointer over the control/field name for a short time. 
After a short delay, a brief hint will be displayed describing what the 
control or field does. If you hold the pointer over a numeric entry 
field, the valid range for that field will be displayed. 
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If these hints do not appear, choose ‘Hints’ from the ‘View’ menu to 
enable them. Conversely, if the hint text is enabled and you wish to 
turn it off, choose ‘Hints’ from the ‘View’ menu. 

NOTE You can alter the properties of the hints, such as the length of the delay before 
hints appear, on the ‘Hints’ page in the System Information application. 

Using the Help 
The Cary WinUV software includes extensive Help, which should be 
your primary source of information on how to use your Cary system. 
It contains descriptions of the various application windows, dialog 
boxes and fields that make up the software, as well as step-by-step 
instructions to help you perform various tasks. It also includes ‘Tips 
and Tricks', ‘Troubleshooting' and ‘Contacts' sections in case you 
encounter difficulties using the software. 

Since the Help system is so extensive, it is advisable to familiarize 
yourself with the contents of the Help by viewing the Help Home 
page. There are a number of ways to open the Help Home page: 

 Click the Windows ‘Start’ button, ‘(All) Programs’, ‘Agilent’, ‘Cary 
WinUV’, ‘Cary Help’. 

 Double-click the ‘Cary WinUV’ folder on the desktop and double-
click ‘Cary Help’. 

 Click ‘Help Topics’ on the ‘Help’ menu when in an application to 
go to the Help Home page. 

You can also make the Help open on the appropriate page containing 
information relevant to the currently open application or dialog box: 

 Click ‘(Application) Help’ (for example, ‘Scan Help’) on the ‘Help’ 
menu when in an application to go to the Home page for that 
application. 

 Click the ‘Help’ button on a dialog box to go to information about 
that dialog box. 

 Press F1 to go to information about the current dialog box. 
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Navigating 
You can move around the Help using the ‘Contents’ on the left of the 
Help window. 

NOTE To display the Contents, click the ‘Show’ button at the top of the Help window. 

 

The Contents sections are accessed by clicking the icons and 
associated text: 

 To expand/contract a section in the Contents list, double-click 
the ‘folder’ icon for that section, or click the ‘+’/‘-’ symbol next to 
the icon. 

 To display a topic, click the text associated with that topic. 

The topics in the Help are often hyperlinked to other related 
information. To return to the previous topic after clicking a 
hyperlink, click the ‘Back’ button at the top of the Help window. 

Searching 
You can quickly search the Help system for specific information 
using key words. 

To search for information on a particular subject: 

1 Click the Search tab (next to the ‘Contents’ tab). 

2 Type the word(s) you want to search for and click the List Topics 
button or press ENTER to list all the relevant pages containing 
the search word/s. 

The number of topics found will be displayed. You can view the 
topics in alphabetical order by clicking ‘Title’ at the top of the list, or 
in the order they appear in the Help by clicking ‘Rank’. 

3 Select the desired topic from the list by highlighting it then 
clicking the Display button. Alternatively, double-click the topic. 
All occurrences of the keyword will be highlighted. 
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4 If this does not provide the information you require, enter a more 
specific word or additional words in the key words field and try 
again. Click the right arrow symbol to the right of the keywords 
field and select any of these words AND, OR, NEAR and NOT to 
place between your keywords.  

TIP Another way to narrow your search is to use the check boxes at the bottom of 
the Search page. For example, selecting ‘Search titles only’ will only list those 
Help topics containing the key word in the title. 

Within a page 

You can skip to a section of interest in a Help page by searching for a 
relevant word. 

To find a key word within a Help page: 

1 Click anywhere on the Help page. 

2 Press CONTROL+F to open the ‘Find’ dialog box. 

3 In the ‘Find what:’ field, enter the word you wish to look for. 

4 If required, limit the Find by selecting an option such as ‘Match 
case’. (This option will only find the words that appear in the 
same letter case (for example, all lower case) as the entered key 
word. 

5 Select the Direction of the Find. Select ‘Up’ to search for the key 
word from the bottom of the page upwards, or ‘Down’ to start the 
Find from the top of a page. 

6 Click the Find Next button or press ENTER to begin the Find. 
The first occurrence of the designated word will be highlighted.  

7 Click the Find Next button or press ENTER repeatedly to jump to 
other occurrences of the key word. When all instances of the 
word have been found, the message ‘Finished searching the 
document’ will be displayed. 
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Tracking ‘favorite’ topics 
You can keep a list of useful Help topics using the ‘Favorites’ option. 

If you come across a topic you may wish to refer to again: 

1 Click the Favorites tab. The title of the page currently visible will 
be present in the ‘Current topic:’ field at the bottom of this tab. 

2 Click the Add button to include this topic to the Favorites list. 

If you would like to view this page later on, you can simply click the 
‘Favorites’ tab and highlight the topic of interest by clicking it, then 
click the ‘Display’ button. (Alternatively, double-click the topic.) 

If a topic is no longer required in the Favorites list, highlight it then 
click the ‘Remove’ button. 

Printing 
You can print one or more Help topics for a particular application. 

To obtain a hard copy of the current Help page: 

1 Click the Print button at the top of the Help window. The ‘Print’ 
dialog box will be displayed. 

2 Click Print. 

To obtain a hard copy of multiple Help pages: 

1 Right-click on the topic in the ‘Contents’ page, and choose Print. 

2 Click Print the selected heading and all sub-topics. 
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This chapter provides step-by-step instructions on how to perform 
common operating procedures using your Cary instrument and 
various software applications. For more detailed information on the 
software applications or your Cary instrument and accessories, refer 
to the extensive Help (see Page 20 for information on using the Help). 

Start an application 
To start an application: 

1 Click the Windows Start button, then (All) Programs, Agilent, 
Cary WinUV and click the application that you wish to run. 
Alternatively, double-click the application icon in the ‘Cary 
WinUV’ folder on the desktop. 

2 Select your instrument type if necessary and click OK to open the 
application. 
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NOTE If you are running a GLP system, you will be prompted to enter a password 
before accessing the application. 

 

NOTE If you are using 21 CFR Part 11 software, you will be prompted to enter a user 
identification, select the appropriate Group and Project and enter a password 
before accessing the application. 

Manually read samples using Advanced Reads  
This procedure describes how to read samples in the Advanced 
Reads application using no accessories. 

1 Set up data collection parameters  

Setup dialog box 

In Advanced Reads, click the Setup button or choose Setup from the 
Menu line to display the ‘Setup’ dialog box and specify the method 
parameters for a new method. 

2 Set up instrument parameters 

Setup dialog box | Cary page 

a In the ‘Wavelength’ field, enter the relevant wavelength. 

b In the ‘Ave. (averaging) Time’ field, enter the required value. 
A good starting point is 0.1 seconds. 

c In the ‘SBW’ field, enter the required spectral bandwidth. 
Unless your method specified another value, use the 
maximum setting. 

d Select ‘Replicates’ or ‘Sample Averaging’. For Replicates, 
enter the number of replicates of each sample that you would 
like read. For Sample Averaging, enter ‘2’ for duplicate 
aliquots of the sample, and so on. 
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NOTE If using a microcell, select a smaller spectral bandwidth. 

 
e Select the ordinate mode you require from the drop-down list 

in the ‘Y Mode’ field. Enter a ‘Factor’ value if you have 
selected ‘Abs*F’. 

3 Set up lamp options  

Setup dialog box | Options page 

a Select Auto lamps off to automatically turn off the lamps at 
the end of the collect. This option is especially useful when 
performing reads overnight or unattended for long periods of 
time. In some Cary instrument models, you may also choose 
to use a third lamp, such as a mercury lamp (if installed). 

b Click the UV/Vis button to use both lamps.  

c Enter the wavelength at which you would like the source 
lamp to change from the ultraviolet to the visible/near-
infrared lamp. The recommended changeover is 
350 nanometers for lamps with an ultraviolet cutoff.  
If you are using a Cary 5000/6000i, also enter the detector 
and grating changeover wavelengths (800 nanometers is 
recommended for both). 

d Under ‘Beam Mode’, select the beam mode that you require. 
In most cases this should be Double Beam and Normal. If 
you select ‘Single Beam’ you also need to enter a value in the 
‘Energy’ field. 

4 Ensure no accessories are selected 

Setup dialog box | Accessories pages 

Make sure no accessories are selected on the ‘Accessories 1’ and 
‘Accessories 2’ pages. 

5 Set up your samples  

Setup dialog box | Samples page  

a Enter the ‘Number of Samples’. The table below expands or 
contracts to match your choice.  
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b In the ‘Samples’ table, enter the name of each sample. You 
can enter up to 20 characters for each name. 

If the samples have the same name with a different numeric 
extension, enter the name in the first sample position and 
then click the ‘Increment’ button. 

You can click the ‘Import’ button to use the names of samples 
stored in a text file. 

6 Set up reporting and printing requirements  

Setup dialog box | Reports page  

a Enter your name in the ‘Name’ field. 

b Enter a comment relating to your experiment in the 
‘Comment’ field. 

c Set up your report style by selecting the appropriate check 
boxes under ‘Options’. For example, select ‘AutoPrint’ to 
automatically obtain a printout of your report. Select 
‘Parameters’ to include your experimental parameters in the 
report.  

NOTE If ‘AutoPrint’ is selected, the system will send the report information to the 
specified printer as well as the Report area. However if ‘AutoPrint’ is not 
selected, the report will only be sent to the Report area. 

 
7 Set up storage of collected data  

Setup dialog box | Auto Store page  

Select Storage off. The method, collected data and report will not be 
automatically saved. However, you can manually save it all at the end 
of the collection.  

8 Set up visual system monitoring  

Select Show Status Display on any of the Setup pages, or from the 
View menu, to display information about your current reaction. 

9 Finish setup 
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Once you are satisfied with your method setup, click OK to confirm 
any changes you have made and close the ‘Setup’ dialog box. 

10 Zero the instrument 

a Click Zero. Alternatively, choose Zero from the Commands 
menu.  

b Place a blank in the sample compartment and click OK.  

11 Read samples 

a Click the Start button, press F9 or choose Start from the 
Commands menu. The ‘Sample Selection’ dialog box will be 
displayed. 

b Select the samples you would like to read, then click OK. 

c The ‘Present Sample’ dialog box will prompt you to place the 
appropriate sample in the sample compartment. Click OK to 
read the sample. 

d Repeat for the remaining samples.  

12 Save your data 

a On the File menu, click Save Data As. 

b Enter the ‘File name’ for this Concentration run. 

c Click Save. The data will be stored as a Batch file. 

13 Export your data 

a On the File menu, click Export report (*.csv). 

b Enter the ‘File name’ for this read. 

c Click Save. The data will be stored as an ASCII spreadsheet, 
with a *.csv file name extension. 
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Perform a calibration and manually measure concentrations using 
Concentration  

This procedure describes how to perform a multi-standard 
calibration and measure sample concentrations in the Concentration 
application using no accessories. 

1 Set up data collection parameters 

Setup dialog box 

In Concentration, click the Setup button or choose Setup from the 
Menu line to display the ‘Setup’ dialog box and specify the method 
parameters for a new method. 

2 Set up instrument parameters  

Setup dialog box | Cary page 

a In the ‘Wavelength’ field, enter the relevant wavelength. 

b In the ‘Ave. (averaging) Time’ field, enter the required value. 
A good starting point is 0.1 second. 

c Enter the required spectral bandwidth in the ‘SBW’ field. Use 
the maximum setting unless your method specifies another 
value. 

NOTE If using a microcell, select a smaller spectral bandwidth. 

 
d Select ‘Replicates’ or ‘Sample Averaging’. For Replicates, 

enter the number of replicates of each sample that you would 
like read. For Sample Averaging, enter ‘2’ for duplicate 
aliquots of the sample, and so on. 

e Select the ‘Y mode’ you require. Click ‘Abs’ to specify 
Absorbance mode or ‘Emission’ if you are measuring 
fluorescence.  

f Enter an upper range and lower range value in the ‘Y min.’ 
and ‘Y max.’ fields to specify the displayed ordinate range. 
These are starting values only. The Cary WinUV software will 
automatically rescale the calibration graph as the standards 
are measured. 
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3 Set up the calibration  

Setup dialog box | Standards page 

a Click the Standards tab to set up the standards and their 
parameters associated with the data collection. 

b Select Calibrate During Run to perform a calibration when 
the ‘Start’ button is clicked. 

c Set the appropriate units for your standards for reporting 
purposes. 

d Set the ‘Standards’ field to the number of standards that you 
are using. The table below will expand or contract to match 
your choice. 

e In the ‘Standards’ table, enter the concentration of each 
standard in the ‘Conc.’ column. 

f Under ‘Fit Type’, select the type of curve fitting required for 
your calibration. 

g Enter the required R2 value or correlation coefficient in the 
‘Min R2’ field. The closer the number is to 1.000, the better 
the fit. Typically, 0.95 is used. 

4 Set up lamp options  

Setup dialog box | Options page 

a Select Auto Lamps Off if you want to automatically turn off 
the lamps at the end of the collect. This option is especially 
useful when performing Concentration runs overnight or 
unattended for long periods of time. 

b Click the UV/Vis button to use both lamps.  

c Enter the wavelength at which you would like the source 
lamp to change from the ultraviolet to the visible/near-
infrared lamp. The recommended changeover is 
350 nanometers for lamps with an ultraviolet cutoff. If you 
are using a Cary 5000/6000i, also enter the detector and 
grating changeover wavelengths (800 nanometers is 
recommended for both). 
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d Under ‘Beam Mode’, select the beam mode that you require. 
In most cases this should be Double Beam and Normal. If 
you select ‘Single Beam’, you also need to enter a value in the 
‘Energy’ field. 

5 Ensure no accessories are selected 

Setup dialog box | Accessories page 

Click the Accessories tab and make sure that no accessories are 
selected. 

6 Set up your samples  

Setup dialog box | Samples page 

a Enter the number of samples in the ‘Number of Samples’ 
field. The table below expands or contracts to match your 
choice. 

b In the ‘Samples’ table, enter the name of each sample. You 
can enter up to 20 characters for each name. 

If the samples have the same name with a different numeric 
extension, enter the name in the first sample position and 
then click the ‘Increment’ button. 

You can click the ‘Import’ button to use the names of samples 
stored in a text file. 

7 Set up reporting and printing requirements  

Setup dialog box | Reports page 

a Enter your name in the ‘Name’ field. 

b Enter a comment relating to your experiment in the 
‘Comment’ field.  

c Set up your report style by selecting the appropriate check 
boxes under ‘Options’. For example, select ‘AutoPrint’ to 
automatically obtain a printout of your report. 
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NOTE If ‘AutoPrint’ is selected, the system will send the report information to the 
specified printer as well as the Report area. However, if ‘AutoPrint’ is not 
selected, the report will only be sent to the Report area and can be viewed by 
choosing ‘Report’ from the ‘View’ menu. 

 
8 Set up weight and volume correction  

Setup dialog box | Samples page 

a Under ‘Weight/Volume Corrections’, select Corrections to 
activate the correction facility. 

b Enter the theoretical sample weight in the ‘Method Weight’ 
field. This is the weight of the sample specified in your 
method. 

c Enter the weight units in the ‘Units’ field. 

d Enter the theoretical sample volume in the ‘Method Volume’ 
field. This is the volume to which the method tells you to 
make the sample. 

e Enter the volume units in the ‘Units’ field. 

f In the ‘Samples’ table, enter the actual weight and volume for 
each sample. 

9 Set up storage of collected data  

Setup dialog box | Auto Store page 

Select Storage off. The method, collected data and report will not be 
automatically saved. However, you can manually save it all at the end 
of the collection. 

10 Set up visual system monitoring  

Select Show Status Display on any of the Setup pages, or from the 
View menu, to display information about your current reaction. 

11 Finish setup  

Once you are satisfied with your method setup, click OK to confirm 
any changes you have made and close the ‘Setup’ dialog box. 
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12 Zero the instrument 

a Click Zero. Alternatively, from the Commands menu, choose 
Zero.  

b Place a blank in the sample compartment and click OK. 

13 Perform the calibration 

a Click the Start button or, from the Commands menu, choose 
Start. The ‘Standard/Sample Selection’ dialog box will be 
displayed. 

b Select the standards and samples to be used in the analysis. 
By default all standards and samples are selected. 

c Click OK. 

d The ‘Present Standard’ dialog box will prompt you to place 
the appropriate standard in the sample compartment. Click 
OK to measure the standard. 

e Repeat until you have measured all of the standards. The 
Cary will calculate the calibration and the correlation 
coefficient.  

NOTE If the set correlation coefficient (R2) value is not met, the Cary will prompt you 
with ‘Min R2 test failed’. When you click ‘OK’, the Cary will then prompt you with 
‘There is no valid calibration. Proceed in Abs (or Emission)?’ If you click ‘Cancel’, 
the Concentration run will finish. If you click ‘Yes’, the Cary will measure the 
absorbance or emission of any presented samples, but will not generate a 
concentration. 

 
14 Measure sample concentration 

a Once all the standards have been read, the ‘Present Sample’ 
dialog box will prompt you to place the appropriate sample 
in the sample compartment. Click OK to measure the sample 
and calculate its concentration. (If replicates have been 
nominated, the concentration is calculated after the final 
sample replicate is read.) 

b Repeat for the remaining samples. 
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15 Save your data 

a On the File menu, click Save Data As. 

b Enter the ‘File name’ for this Concentration run. 

c Click Save. The data will be stored as a Batch file. 

16 Export your data 

a On the File menu, click Export report (*.csv). 

b Enter the ‘File name’ for this read. 

c Click Save. The data will be stored as an ASCII spreadsheet, 
with a *.csv file name extension. 

Enzyme Kinetics 

Perform a temperature-controlled Enzyme Kinetics run using the 
Multicell Holder 
This procedure describes how to perform a multicell, multi-rate 
Enzyme Kinetics run at 37 °C using the Temperature Controller 
accessory with the Multicell Holder accessory (Cary 
100/300/4000/5000/6000i). 

1 Set up data collection parameters  

Setup dialog box  

In Enzyme Kinetics, click the Setup button or select Setup from the 
Menu line to display the ‘Setup’ dialog box and specify the method 
parameters for a new method. 

2 Set up the Multicell Holder accessory 

Setup dialog box | Accessories page 

As various options do not become available until the appropriate 
accessories are selected, you need to select these first. 

a Select Use Cell Changer to enable the accessory.  

b For Cary 100/300 instruments, choose the type of Multicell 
Holder you are using (6 x 6 or 8 x 6). Ensure that you have 
this accessory installed before starting the run. 
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NOTE If you are using a Series I 6 x 6 (Cary 100/300), you must calibrate the cell 
changer using the Align application before starting experiments. 

 
c Choose Select Cells and select the cells you require from the 

available cells under ‘Use Cells’. 

NOTE For Front Beam analysis, select ‘Cell 1–Cell 6’ (6 x 6) or ‘Cell 1–Cell 8’ (8 x 6). 
This will ensure that all front cell positions in the Multicell Holder will be 
measured during your enzyme kinetics analysis. 

 
d Select Multi Zero to turn on the ‘Multi Zero’ facility.  

e Ensure that Blank Correction is not selected. 

3 Set up accessories for reaction temperature control and 
temperature display  

a If you are not using a Peltier-controlled accessory (for 
example, the water-thermostatted 8 x 6), ensure that you 
have the Temperature Controller accessory installed before 
starting the run, and,  

(i) Select Automatic Temperature Setting and select 
Temperature Controller to enable the accessory. 

(ii) Set the monitoring temperature by entering the Block 
temperature as 37 °C. (The monitoring device is selected in 
Step 4d). 

b Under ‘Temperature Display’, select Block and Probe 1 to 
view the temperature of the Multicell Holder block and one 
temperature probe in the ‘Status Display’ window.  

4 Set up instrument parameters 

Setup dialog box | Cary page 

a Enter the ‘Wavelength’, ‘SBW’ (spectral bandwidth) and ‘Ave. 
(averaging) Time’ you require in the corresponding fields. 

b Select the ordinate mode you require. Click ‘Abs’ to specify 
Absorbance mode or ‘%T’ to specify percent Transmittance.  
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NOTE The ‘%T’ mode is used when performing fluorescence kinetics measurements 
using the Total Fluorescence accessory or the Fluorescence Fiber Optic Probe. 

 
c Enter an upper range and lower range value in the ‘Y min.’ 

and ‘Y max.’ fields to specify the displayed ordinate range.  

d In the ‘Monitor’ field, choose where you are going to monitor 
the temperature.  

5 Set up rate parameters   

a Under ‘Collect Timing’, select Advanced Collect. 

NOTE The ‘Advanced Collect’ facility enables you to collect data more frequently during 
the crucial stages of your reaction, and to collect data less frequently where you 
know there will be little activity. 

 
b Enter the number of different reaction rates that you require 

in the ‘Number of Stages’ field. The number you set here will 
be reflected in the table below. 

c Vary the number of data points collected per cell per run by 
setting the ‘Dwell time’ for each rate stage. 

d Specify how long the Cary will wait after reading each cell 
before it starts another reading cycle, by setting the ‘Cycle 
time’ for each rate stage. 

e Specify the duration of the measurement by setting the ‘Stop 
time’ for each rate stage.  

6 Set up lamp and graphics options  

Setup dialog box | Options page 

a Select Auto Lamps Off if you want to automatically turn off 
the lamps at the end of a collect. This is especially useful 
when performing data collections overnight or unattended 
for long periods of time.  

b Click UV/Vis if you want both lamps on during the run.  
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c Enter your required ‘Source Changeover’ and ‘Detector 
Changeover’ (Cary 5000 only) wavelengths in the 
corresponding fields. If you are using a Cary 5000/6000i, also 
enter the detector and grating changeover wavelengths 
(800 nanometers is recommended for both). 

d Set the ‘Slit Height’ to full or reduced (Cary 4000/5000/6000i 
only). 

e Under ‘Display Options’, choose ‘Individual Data’ to display 
the collected data of each sample in individual graph boxes. 
Choose ‘Overlay Data’ to superimpose the collected data of 
each sample in the Enzyme Kinetics run in one graph box.  

7 Set up V0 calculation 

Setup dialog box | Analyze page 

a Set the start and stop times for your V0 calculation.  

b Enter the required product absorptivity and cell pathlength 
for your reaction. 

8 Set up calculations for the maximum rate (Vmax) and substrate 
concentration that gives half the maximum rate (Km) 

a Under ‘Analyze’, select the method by which the data 
obtained from your selection under ‘Plot/Fit’ will be 
calculated. Choose ‘Linear Least Square’ or ‘Marquardt’. 

b Choose the inhibitor model for your analysis.  

c Select the Plot/Fit type/s that will be used to determine Vmax 
and Km values. 

d Select Auto Calculate to automatically perform enzyme 
kinetics calculations at the end of each run.  

9 Set up reporting and printing requirements  

Setup dialog box | Reports page 

a Enter your name in the ‘Name’ field.  

b Enter a comment relating to your experiment in the 
‘Comment’ field. 

c Set up your report style by selecting the appropriate items 
under ‘Options’. For example, select ‘Auto Print’ to 
automatically obtain a printout of your report. Select ‘Graph’ 
to include a graph in the generated report.  
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NOTE If ‘Auto Print’ is selected, the system will send the report information to the 
specified printer as well as to the Report area. 

 
d Select the Autoconvert option you require. If you choose 

‘Select for ASCII (csv)’ or ‘Select for ASCII (csv) with Log’, 
the system will automatically generate a report and store the 
data in the Cary format as well as ASCII XY pairs format in 
the current folder.  

10 Set up storage of collected data  

Setup dialog box | Auto Store page 

Select Storage On (Prompt at Start), to set up the Cary to prompt 
you for a file name before the start of an Enzyme Kinetics reaction.  

11 Set up visual system monitoring  

Select Show Status Display on any of the Setup pages, or from the 
View menu, to display information about your current reaction. 

12 Finish setup  

Click OK to save any changes you have made and close the ‘Setup’ 
dialog box. Depending on the cells selected in the Multicell Holder, 
the Cary may inform you that it will perform a dual single beam 
calibration. Click OK. 

13 Zero the instrument  

a Click Zero or choose Zero from the Commands menu. A ‘Cell 
Loading Guide’ will be displayed.  

b If you like, change the names of the blank samples. 

c Place the blank solution(s) in the correct cell positions and 
click OK. The system will perform an instrument zero on the 
blank solution(s).  
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NOTE If you had chosen not to use the ‘Multi Zero’ facility in Step 2d, the system will 
prompt you to enter the blank solution into the instrument. You must make sure 
that you place the blank solution in the cell position that is currently in the light 
path. Once you click ‘OK’, the system will perform a zero on the cell position in 
the light path, that is, the system will not reset the Multicell Holder to position 1. 

 
14 Start the run  

a Click Start or choose Start from the Commands menu. Do 
not add your active reagent at this time. The system will 
display a ‘Cell Loading Guide’.  

b If you like, change the names of the samples. 

c Place the sample solution(s) in the correct cell positions and 
click OK. The system will set up the Graphics area and 
display the ‘Save File’ dialog box. 

d Enter the file name and click Save. The ‘Sync Start’ dialog 
box will be displayed. 

e Reset the Multicell Holder to position to cell 1 by clicking the 
Reset Slide button. Add your active reagent just before the 
countdown reaches 0:00, or commence the data collection by 
clicking OK.  

15 Enter substrate and inhibitor concentrations (two options) 

Once the run has started: 

a Open the ‘Setup’ dialog box by clicking the Setup button or 
by choosing Setup from the Menu line. 

b Click the Samples tab. In the ‘S’ column, enter the Substrate 
concentration in micromoles. In the ‘I’ column, enter the 
Inhibitor concentration in micromoles. 

NOTE If no information has been entered during the collect, no calculation is 
performed. 
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You can also use the ‘User Data Form’ to enter the Inhibitor and 
Substrate concentrations:  

a Open the ‘User Data Form’, by right-clicking in a graph box 
and clicking User Data Form from the menu, or by choosing 
User Data Form from the Graph menu. 

b The table that appears has Data Names and may have V0 
values already entered in the first two columns. In the third 
and fourth columns, enter your values for [S] and [I] in 
micromoles per liter. 

c Click OK. Your [S] and [I] values are now ready to be used in 
calculations, and the Cary will perform the calculations at 
the end of the run. 

Kinetics 
The following Kinetics procedures are described: 

 Performing a temperature-controlled Kinetics run using the 
Multicell Holder 

 Performing a multi-wavelength, single cell, single rate Kinetics 
run 

Perform a temperature-controlled Kinetics run using the Multicell 
Holder 
This procedure describes how to perform a multicell, multi-rate 
Kinetics run at 37 °C using the Temperature Controller accessory 
with the Multicell Holder accessory (Cary 100/300/4000/5000/6000i). 

1 Set up data collection parameters 

Setup dialog box 

Click the Setup button or choose Setup from the Menu line to display 
the ‘Setup’ dialog box and specify the method parameters for a new 
method. 

2 Set up the Multicell Holder accessory 

Setup dialog box | Accessories page 
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As various options do not become available until the appropriate 
accessories are selected, you need to select these first. 

a Select Use Cell Changer to enable the accessory.  

b For Cary 100/300 instruments, choose the type of Multicell 
Holder you are using (6 x 6 or 8 x 6). Ensure that you have 
this accessory installed before starting the run. 

NOTE If you are using a Series I 6 x 6 (Cary 100/300), you must calibrate the cell 
changer using the Align application before starting experiments. 

 
c Click Select Cells and select the cells you require from the 

available cells under ‘Use Cells’. 

For Front Beam analysis, select ‘Cell 1 to Cell 6’ (6 x 6) or 
‘Cell 1 to Cell 8’ (8 x 6). This will ensure that all front cell 
positions in the Multicell Holder will be measured during 
your Kinetics analysis. 

d Select Multi Zero. 

e Ensure ‘Blank Correction’ is not selected. 

3 Set up accessories for reaction temperature control and 
temperature display 

a If you are not using a Peltier-controlled accessory (for 
example, the water-thermostatted 8 x 6), ensure that you 
have the Temperature Controller accessory installed before 
starting the run, and, 

(i) Select Automatic Temperature Setting and select 
Temperature Controller to enable the accessory. 

(ii) Set the monitoring temperature by entering the Block 
temperature as 37 °C. (The monitoring device is selected in 
Step 4e). 

b Under ‘Temperature Display’, select Block and Probe 1 to 
turn on monitoring of the Multicell Holder block and one 
temperature probe. 
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4 Set up instrument parameters  

Setup dialog box | Cary page 

a Enter the ‘Wavelength’, ‘SBW’ (spectral bandwidth) and ‘Ave. 
(averaging) Time’ you require in the corresponding fields. 

b Select the ordinate mode you require. Click ‘Abs’ to specify 
absorbance mode or ‘%T’ to specify percent transmittance.  

c Enter an upper range and lower range value in the ‘Y min.’ 
and ‘Y max.’ fields to specify the displayed ordinate range.  

d Select ‘Min.’ or ‘Sec.’ to set the abscissa (X). 

e In the ‘Monitor’ field, choose where you are going to monitor 
the temperature. The ‘Start’ button will not be enabled until 
the temperature of the selected monitor is within 0.5 °C of 
the block temperature set on the ‘Accessories’ page (Step 3a 
(ii)). 

5 Set up rate parameters  

a Under ‘Collect Timing’, select Advanced Collect. This enables 
you to set up different data collection procedures for the 
multiple rates in your reaction. 

NOTE The ‘Advanced Collect’ facility enables you to collect data more frequently during 
the crucial stages of your reaction, and to collect data less frequently where you 
know there will be little activity. 

 
b Enter the number of different reaction rates that you require 

in the ‘Number of Stages’ field. The number you set here will 
be reflected in the table below. 

c Vary the number of data points collected per cell, per run, by 
setting the ‘Dwell time’ for each rate stage. 

d Specify how long the Cary will wait after reading each cell 
before it starts another reading cycle by setting the ‘Cycle 
time’ for each rate stage. 

e Specify the duration of the Kinetics run by setting the ‘Stop 
time’ for each rate stage. 
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6 Set up lamp and graphics options 

Setup dialog box | Options page 

a Select Auto Lamps Off if you want to automatically turn off 
the lamps at the end of a collect. This is especially useful 
when performing Kinetics data collections overnight or 
unattended for long periods of time. 

b Click the UV/Vis button if you want both of the lamps on 
during the run.  

c Enter your required ‘Source Changeover’ and ‘Detector 
Changeover’ (Cary 5000 only) wavelengths in the 
corresponding fields. If you are using a Cary 5000/6000i, also 
enter the detector and grating changeover wavelengths (800 
nanometers is recommended for both). 

d Set the ‘Slit Height’ to full or reduced (Cary 4000/5000/6000i 
only). 

e Under ‘Display Options’ choose ‘Individual Data’ to display 
the collected data of each sample in individual graph boxes. 
Choose ‘Overlay Data’ to superimpose the collected data of 
each sample in the Kinetics run in one graph box. 

7 Set up analysis parameters 

Setup dialog box | Analyze page 

a Select Auto Calculate to automatically perform a rate 
calculation at the end of each run.  

b Select Advanced Calculate to set up multiple rate 
calculations for the Kinetics run.  

c Enter the number of different rate calculations that you 
require in the ‘Number of Stages’ field. The number you set 
here will be reflected in the table below. 

d Set up the stage ‘Start’ and ‘Stop’ times and select the 
reaction order for each of these reaction stages.  
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NOTE If you select a ‘first order’ or ‘second order’ Simple Calculate rate calculation, 
you can use the items under ‘Manual Guess’ to manually enter the parameters: 
A0, Alnf and Rate (k). 

 
e Enter a value in the ‘Factor’ field to calculate enzyme 

activity. This multiplication factor is applied to the 
absorbance. 

f If you are performing a second order reaction, enter the 
initial concentration of substrate before reaction. 

g Select Display Fit to automatically overlay the calculated 
lines of best fit onto the plotted data. 

8 Set up reporting and printing requirements 

Setup dialog box | Reports page 

a Enter your name in the ‘Name’ field.  

b Enter a comment relating to your experiment in the 
‘Comment’ field. 

c Set up your report style by selecting the appropriate check 
boxes under ‘Options’. For example, select ‘Auto Print’ to 
automatically obtain a printout of your report. Select ‘Graph’ 
to include a graph in the generated report.  

NOTE If ‘Auto Print’ is selected, the system will send the report information to the 
specified printer as well as to the Report area. 

 
d Select Include X-Y Pairs Table to view a list of abscissa 

values and their corresponding ordinate values. 

e Select the ‘Autoconvert’ option you require. If you select 
‘ASCII’ or ‘ASCII with Log’, at the end of the data collection, 
the system will automatically generate a report and store the 
data in the Cary format as well as ASCII XY pairs format in 
the current folder. 
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9 Set up storage of collected data 

Setup dialog box | Auto Store page 

Select Storage On (Prompt at Start) to set the Cary to prompt you 
for a file name, before the start of a Kinetics reaction. 

10 Set up visual system monitoring 

Select Show Status Display on any of the Setup pages, or from the 
View menu, to display information about your current reaction. 

11 Finish setup 

Click OK to save any changes you have made and close the ‘Setup’ 
dialog box. 

12 Zero the instrument 

a Click Zero or from the Commands menu, choose Zero. A 
‘Cell Loading Guide’ will be displayed.  

b If you like, change the names of the blank samples. 

c Place the blank solution(s) in the correct cell positions and 
click OK. The system will perform an instrument zero on the 
blank solution(s). 

13 Start the run 

a Click the Start button or from the Commands menu, choose 
Start. Do not add your active reagent at this time. The 
system will display the ‘Save As’ dialog box.  

b Enter the ‘File name’ of this Kinetics run and click Save. The 
system will display a ‘Cell Loading Guide’. 

c If you like, change the names of the samples. 

d Place the sample solution(s) in the correct cell positions and 
click OK. The system will set up the Graphics area and then 
the ‘Sync Start’ dialog box will be displayed. 

e Reset the Multicell Holder position to cell 1 by clicking the 
Reset Slide button.  

f Add your active reagent just before the countdown reaches 
0:00, or commence the data collection by clicking OK. 
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Perform a multi-wavelength, single cell, single rate Kinetics run 
This procedure describes how to perform a multi-wavelength, single 
cell Kinetics run at ambient temperature (Cary 
100/300/4000/5000/6000i). 

1 Set up data collection parameters  

Setup dialog box 

In Kinetics, click the Setup button or choose Setup from the Menu 
line to display the ‘Setup’ dialog box and specify the method 
parameters for a new method. 

2 Set up instrument parameters  

Setup dialog box | Cary page 

a In the ‘Wavelength’ field, enter the relevant wavelengths. 

b In the ‘SBW’ field, enter the required spectral bandwidth. 

c In the ‘Ave. (averaging) Time’ field, enter the required value. 

d Select the ordinate mode you require. Click ‘Abs’ to specify 
the absorbance mode or ‘%T’ to specify percent 
transmittance. 

e Enter an upper range and lower range value in the ‘Y min.’ 
and ‘Y max.’ fields to specify the ordinate range. 

f Select ‘Min.’ or ‘Sec.’ to set the abscissa (X). 

3 Set up rate parameters  

a Under ‘Collect Timing’, select Simple Collect to set up a 
single rate for your reaction. 

b Specify how long the Cary will wait after reading each cell 
before it starts another reading cycle by setting the cycle 
time. 

c Specify the duration of the Kinetics run by setting the stop 
time. 
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4 Set up lamp and graphics options  

Setup dialog box | Options page 

a Select Auto Lamps Off if you want to automatically turn off 
the lamps at the end of a collect. This is especially useful 
when performing Kinetics data collections overnight or 
unattended for long periods of time.  

b Click the UV/Vis button if you want both lamps on during the 
run.  

c Enter your required ‘Source Changeover’ and ‘Detector 
Changeover’ (Cary 5000 only) wavelengths in the 
corresponding fields. If you are using a Cary 5000/6000i, also 
enter the detector and grating changeover wavelengths (800 
nanometers is recommended for both). 

d Set the ‘Slit Height’ to full or reduced (Cary 4000/5000/6000i 
only). 

e Under ‘Display Options’, select ‘Individual Data’ to display 
the collected data of each sample in individual graph boxes. 
Select ‘Overlay Data’ to superimpose the collected data of 
each sample in the Kinetics run in one graph box. 

5 Set up accessories  

Setup dialog box | Accessories page 

Click the Accessories tab and ensure that no accessories are 
selected. 

6 Set up analysis parameters  

Setup dialog box | Analyze page 

a Select ‘Auto Calculate’ to automatically perform a rate 
calculation at the end of each run. Or select ‘Simple 
Calculate’ to perform one rate calculation for the entire 
Kinetics run.  

b Set up the reaction start and stop times and select the 
reaction order.  

c If you select a ‘first order' or ‘second order' Simple Calculate 
rate calculation, you can use the ‘Manual Guess’ items to 
manually enter the parameters: A0, AInf and Rate (k).  
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NOTE If you do not choose ‘Manual Guess’, the Cary system will automatically 
calculate the values: A0, AInf and Rate when the ‘Start’ button is clicked. 

 
d Enter a value in the ‘Factor’ field to calculate enzyme 

activity. This multiplication factor is applied to the 
absorbance. 

e If you are performing a second order reaction, enter the 
initial concentration of substrate before reaction. 

f Select Display Fit to automatically overlay the calculated 
lines of best fit onto the plotted data. 

7 Set up reporting and printing requirements  

Setup dialog box | Reports page 

a Enter your name in the ‘Name’ field.  

b Enter a comment relating to your experiment in the 
‘Comment’ field. 

c Set up your report style by selecting the appropriate check 
boxes under ‘Options’. For example, select ‘Auto Print’ to 
automatically obtain a printout of your report. Select ‘Graph’ 
to include a graph in the generated report.  

NOTE If ‘Auto Print’ is selected, the system will send the report information to the 
specified printer as well as the Report area. 

 
d Select Include X-Y Pairs Table to view a list of abscissa 

values and their corresponding ordinate values. 

e Select the autoconvert option you require. If you select 
‘ASCII’ or ‘ASCII with Log’, at the end of the data collection, 
the system will automatically generate a report and store the 
data in the Cary format as well as ASCII XY pairs format in 
the current folder. 
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8 Set up storage of collected data  

Setup dialog box | Auto Store page 

Select Storage Off. The method, collected data and report will not be 
saved. Or, select ‘Storage On Prompt at Start’ to set the Cary to 
prompt you for a file name before the start of a run; or ‘Storage On 
Prompt at End’ to set the Cary to prompt you for a file name at the 
end of a run. 

9 Set up visual system monitoring  

Select Show Status Display on any of the Setup pages, or from the 
View menu, to display information about your current reaction. 

10 Finish setup  

Once you are satisfied with your method setup, click OK to confirm 
any changes you have made and close the ‘Setup’ dialog box. 

11 Zero the instrument  

a Click Zero. Alternatively, choose Zero from the Commands 
menu. A ‘Loading Guide’ will be displayed.  

b If you like, change the name of the blank. 

c Place the blank solution in the sample compartment and click 
OK. The system will perform an instrument zero on the blank 
solution(s). 

12 Start the run  

a Click the Start button, or choose Start from the Commands 
menu. Do not add your active reagent at this time. The 
system will display a ‘Loading Guide’.  

b If you like, change the names of the sample. 

c Place the sample solution in the front cell holder and click 
OK. The system will set up the Graphics area and then 
display the ‘Sync Start’ dialog box. 

d Add your active reagent just before the countdown reaches 
0:00, or commence the data collection by clicking OK. The 
Cary will start the Kinetics data collection. 
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13 Save your data  

a On the File menu, and click Save Data As. 

b Enter the ‘File name’ for this Kinetics run. 

c Click Save. The data will be stored as a Batch file. 

RNA-DNA Estimation 

Perform a temperature-controlled RNA-DNA run using the Multicell 
Holder  
This procedure describes how to perform a multicell RNA-DNA run 
with multi zero and multi baseline at 37 °C using the Temperature 
Controller accessory with the Multicell Holder accessory (Cary 
100/300/4000/5000/6000i). 

1 Set up data collection parameters  

Setup dialog box 

In RNA-DNA, click the Setup button or choose Setup from the Menu 
line to display the ‘Setup’ dialog box and specify the method 
parameters for a new method. 

2 Set up the Multicell Holder accessory  

Setup dialog box | Accessories 1 page 

As various options do not become available until the appropriate 
accessories are selected, you need to select these first.  

a Select Use Cell Changer to enable the accessory. 

b For Cary 100/300 instruments, choose the type of Multicell 
Holder you are using (6 x 6 or 8 x 6). Ensure that you have 
this accessory installed before starting the run. 

NOTE If you are using a Series I 6 x 6 (Cary 100/300), you must calibrate the cell 
changer using the Align application before starting experiments. 
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c Click Select Cells and select the cells you require under ‘Use 
Cells’. For double beam analysis, select ‘Cell 1 through to the 
Cell 6’ (6 x 6) or ‘Cell 1 through to Cell 8’ (8 x 6). 

d Select Multi Zero.  

The ‘Multi Baseline’ facility will not be accessible until completing 
Step 4. 

3 Set up accessories for reaction temperature control and 
temperature display 

a If you are not using a Peltier-controlled accessory (for 
example, the water-thermostatted 8 x 6), ensure that you 
have the Temperature Controller accessory installed before 
starting the run, and,  

(i) Select Automatic Temperature Setting and select 
Temperature Controller to enable the accessory. 

(ii) Set the monitoring temperature by entering the block 
temperature as 37 °C. (The monitoring device is selected in 
Step 4).  

b Under ‘Temperature Display’, select Block and Probe 1 to 
view the temperature of the Multicell Holder block and one 
temperature probe in the ‘Status Display’ window.  

4 Set up instrument parameters  

Setup dialog box | Cary and Baseline pages  

a Enter the first and second wavelengths at which you would 
like to measure your sample/s. 

b If required, select Background Correction and enter a 
background wavelength in the corresponding field. 

c Choose the desired temperature monitoring device in the 
‘Monitor’ field. The ‘Start’ button will not be enabled until the 
temperature of the selected Monitor is within 0.5 °C of the 
Block temperature set on the ‘Accessories 1’ page (Step 3a 
(ii)). 

d To perform a wavelength scan, select Scan Samples and set 
the ‘Start’, ‘Stop’ and ‘Rate’ for the scan. The ‘Baseline’ tab 
will be displayed.  

e Click the Baseline tab. 
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f Select Baseline correction. To use a previously stored 
baseline, click the ‘Baseline’ button and browse for the 
appropriate file. Otherwise, you can perform your baseline 
correction at the beginning of the run. To perform a ‘Multi 
Baseline’, you can now go back to the ‘Accessories 1’ page 
and select ‘Multi Baseline’.  

5 Set up source, SBW and display options  

Setup dialog box | Options page  

a Select Auto Lamps Off if you want to automatically turn off 
the lamps at the end of a collect. This is especially useful 
when performing data collections overnight or unattended 
for long periods of time.  

b Click UV/Vis if you want both lamps on during the run.  

c Enter your required ‘Source Changeover’ and ‘Detector 
Changeover’ (Cary 5000 only) wavelengths in the 
corresponding fields. If you are using a Cary 5000/6000i, also 
enter the detector and grating changeover wavelengths (800 
nanometers is recommended for both). 

d Enter the spectral bandwidth of your instrument in the ‘SBW’ 
field. 

e Set the appropriate ‘Slit Height’ (Cary 4000/5000/6000i only). 

f Under ‘Display Options’, select ‘Individual Data’ to display 
the collected data of each sample in individual graph boxes. 
Choose ‘Overlay Data’ to superimpose the collected data of 
each sample in the run in one graph box.  

6 Set up your samples 

Setup dialog box | Samples page  

a Enter the number of samples that you are going to use in the 
‘Number of Samples’ field. The ‘Sample Names’ list below will 
expand or contract to match your choice. 

b In the ‘Sample Names’ list, enter the name of each sample. 
You can enter up to 20 characters for each name. 

If the samples have the same name with a different numeric 
extension, enter the name in the first sample position and 
then click the ‘Increment’ button.  
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Click the ‘Import Names’ button to use names from a stored 
text file. 

c Clear the red tick for any samples not required. 

d If you would like multiple readings of the same aliquot, select 
Replicates and enter the number of replicates required.  

7 Set up analysis parameters 

Setup dialog box | Analyze page 

If you would like to calculate any Warburg Christian coefficients or 
260 nm Factor parameters, make your selections here. 

8 Set up reporting and printing requirements  

Setup dialog box | Reports page  

a Enter your name in the ‘Name’ field.  

b Enter a comment relating to your experiment in the 
‘Comment’ field. 

c Set up your report style by selecting the appropriate check 
boxes under ‘Options’. For example, select ‘Auto Print’ to 
automatically obtain a printout of your report. If you have 
selected ‘Scan Samples’ on the ‘Cary’ page, select ‘Graph’ to 
include a graph in the generated report.  

NOTE If ‘Auto Print’ is selected, the system will send the report information to the 
specified printer as well as to the Report area. 

 
d Select the ‘Autoconvert’ option you require. If you choose 

‘Select for ASCII (csv)’ or ‘Select for ASCII (csv) with Log’, at 
the end of the data collection, the system will automatically 
generate a report and store the data in the Cary format as 
well as ASCII XY pairs format in the current folder.  
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9 Set up storage of collected data  

Setup dialog box | Auto Store page  

Select Storage On (Prompt at Start), to set the Cary to prompt you 
for a file name before the start of the RNA-DNA run.  

Set up visual system monitoring  

Select Show Status Display on any of the Setup pages, or from the 
View menu, to display information about your current reaction. 

10 Finish setup  

Click OK to save any changes you have made and close the ‘Setup’ 
dialog box. 

11 Zero the instrument  

a Click Zero or choose Zero from the Commands menu. A ‘Cell 
Loading Guide’ will be displayed.  

b Place the blank solution(s) in the correct cell positions and 
click OK. The system will perform an instrument zero on the 
blank solution(s). 

NOTE If you have chosen not to use the ‘Multi Zero’ facility in Step 2d, the system will 
prompt you to enter one blank solution into the instrument. In this case, it is 
important to ensure that you place this blank solution in the cell position that is 
currently in the light path. On clicking ‘OK’, the system will perform a zero on the 
cell position in the light path, that is, the system will not reset the Multicell 
Holder to position 1. 
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12 Perform a baseline correction (if not using a stored baseline) 

If you have selected to perform a baseline correction (Step 4f) and 
are not using a stored baseline, take a baseline reading now by 
following the steps below. Otherwise, proceed to Step 13. 

a Click Baseline. A ‘Cell Loading Guide’ will be displayed.  

b Load the blank/s as shown. 

c Click OK. The system will collect a baseline for each cell in 
use and the word ‘baseline’ will be displayed above the 
ordinate instrument status reading.  

13 Start the run  

a Click the Start button to start a data collection. Alternatively 
you can choose Start from the Commands menu. The ‘Save 
As’ dialog box will be displayed.  

b Enter the ‘File name’ for this RNA-DNA run and click Save. 
The system will display a ‘Cell Loading Guide’.  

c Place the sample solution(s) in the correct cell positions and 
click OK. The system will then begin reading the samples and 
printing the results to the Report area.  
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Scan 
The following Scan procedures are described. 

 Performing a scan with baseline correction (Cary 100–6000i) 

 Performing a scan in Signal-to-Noise mode (Cary 100-6000i) 

 Performing a scan in Independent mode (Cary 5000/6000i)  

Perform a scan with baseline correction 
This procedure describes how to perform a wavelength scan from 
800 nm to 200 nm with baseline correction (Cary 
100/300/4000/5000/6000i). 

1 Set up data collection parameters  

Setup dialog box 

In Scan, click the Setup button or choose Setup from the Menu line 
to display the ‘Setup’ dialog box and specify the method parameters 
for a new method. 

2 Set up instrument parameters 

Setup dialog box | Cary page 

a Set the appropriate abscissa mode in the ‘X Mode’ field. 

b Set the wavelength range by entering the values you require 
in the ‘Start’/‘Stop’ fields. 

c In the ‘Y Mode’ field, select the ordinate mode. 

d Enter an upper and lower range in the ‘Y min.’ and ‘Y max.’ 
fields to specify the displayed ordinate range.  

e Set the speed of the data collection by setting the ‘Ave. Time’ 
and ‘Data Interval’. The Data Interval is the wavelength 
increment between data points. The ‘Scan Rate’ will 
automatically update when selected. 

f Make sure ‘Cycle Mode’ is not selected. 
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3 Set up SBW, lamp and graphics options 

Setup dialog box | Options page 

a Set the ‘SBW’ (spectral bandwidth). 

b Set the ‘Beam Mode’ for the run (usually ‘Double’). 

c For Cary 5000/6000i, the fixed SBW is used to automatically 
alter the Energy level and maintain a constant signal level.  

d For Cary 4000/5000/6000i, set the ‘Slit Height’ to Full. 

e Click the UV/Vis button if you want both lamps on during the 
run.  

f Select Auto Lamps Off if you want to automatically turn off 
the lamps at the end of a collect. This is especially useful 
when performing Scan runs overnight, or unattended for long 
periods of time.  

g Do not select ‘Signal-to-Noise Mode’. 

h Under ‘Display Options’, select ‘Individual Data’ to display 
the collected data of each sample in individual graph boxes. 
Choose ‘Overlay Data’ to superimpose the collected data of 
each sample in the Scan run in one graph box.  

Setup dialog box | Independent page 

If you are using a Cary 5000/6000i, do not change any options on the 
‘Independent’ page.  

4 Set up the baseline correction 

Setup dialog box | Baseline page 

Select Baseline Correction to perform a baseline correction on each 
sample data point.  

NOTE You can use a stored baseline by clicking ‘Baseline’ and opening the saved *.csw 
baseline file. 

 
  



How To… 

Cary WinUV Software Manual 71 

5 Ensure no accessories are selected 

Setup dialog box | Accessories 1 page 

Make sure that no options are selected on this page and that no 
accessories are installed. 

Setup dialog box | Accessories 2 page 

Make sure that no options are selected on this page and that no 
accessories are installed. 

Setup dialog box | Accessories 3 page 

Make sure that no options are selected on this page and that no 
accessories are installed. 

6 Set up reporting and printing requirements 

Setup dialog box | Reports page 

a Enter your name in the ‘Name’ field.  

b Enter a comment relating to your sample in the ‘Comment’ 
field.  

c Set up your report style by selecting the appropriate check 
boxes under ‘Options’. For example, select ‘AutoPrint’ to 
automatically obtain a printout of your report. Select ‘Graph’ 
to include a graph in the printed report.  

NOTE If ‘AutoPrint’ is selected, the system will send the report information to the 
specified printer as well as the Report area. 

 
d Set up the ‘Peak Table’ reporting.  

(i) Select Peak Labels.  

(ii) Click the Peak Information button and choose the ‘Peak 
Type’, the ‘Labels Type’, and set the ‘Peak Threshold’. Click 
OK. 

(iii) Select Maximum Peak to report the peak with the largest 
peak threshold that exceeds the Peak Threshold value. 
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(iv) Select All Peaks to report all peaks meeting the Peak 
Style criterion and exceeding the Threshold value. 

e Set up ‘X-Y pairs’ reporting, if required. You can use the 
actual Data Interval by which the data was collected, or you 
can make the Cary interpolate the points to a new Interval. 

f Select the ‘Autoconvert’ option you require. If you select 
‘Select for ASCII (csv)’ or ‘Select for ASCII (csv) with Log’, at 
the end of the data collection the system will automatically 
generate a report and store the data in the Cary format as 
well as ASCII XY pairs format in the current folder. 

7 Set up storage of collected data 

Setup dialog box | Auto Store page 

Select Storage On (Prompt at Start).  

Set up visual system monitoring 

Select Show Status Display on any Setup page, or from the View 
menu, to display information about your current reaction. 

8 Finish setup 

Once you are satisfied with your method setup, click OK to confirm 
any changes you have made and close the ‘Setup’ dialog box. 

9 Zero the instrument 

Click Zero or choose Zero from the Commands menu to perform a 
zero.  

10 Measure a baseline 

a Click Baseline or choose Baseline from the Commands 
menu.  

b When prompted, insert the blank sample into the sample 
compartment front beam and click OK. After the baseline is 
collected, the word ‘baseline’ will be displayed in red in the 
ordinate status box, indicating that you are in baseline 
correction mode and have a valid baseline file for the 
correction. 
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NOTE If the word ’baseline’ is gray and in italics, the baseline file is still valid. The gray 
and italics indicate that the Cary is idling outside the abscissa range of the 
baseline file. 

 
11 Start the run 

Click the Start button or choose Start from the Commands menu to 
start the Scan run.  

12 Name the data file and samples 

a When you click Start, the ‘Save As’ dialog box will be 
displayed. Enter the appropriate ‘File name’ for the data and 
click Save. 

b The ‘Sample Name’ dialog box will be displayed. Enter the 
appropriate name for your sample and click OK. The Scan 
run will commence and the corrected trace will be displayed 
in the Graphics area. At the end of the run, the Cary will 
create the report and also print it, if ‘AutoPrint’ has been 
selected on the ‘Reports’ page of the ‘Setup’ dialog box. 

Perform a scan in Signal-To-Noise mode 
This procedure describes how to perform a wavelength scan from 
800 nm to 200 nm in signal-to-noise mode  
(Cary 100/300/4000/5000/6000i). 

1 Set up data collection parameters  

Setup dialog box 

In Scan, click the Setup button or choose Setup from the Menu line 
to display the ‘Setup’ dialog box and specify the method parameters 
for a new method. 

2 Set up instrument parameters 

Setup dialog box | Cary page 

a Set the appropriate abscissa mode for the scan in the ‘X 
Mode’ field. 
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b Set the wavelength range for the scan by entering the values 
you require in the ‘Start’ and ‘Stop’ fields. 

c In the ‘Y Mode’ field, select the ordinate mode. 

d Enter an upper and lower range in the ‘Y min.’ and ‘Y max.’ 
fields to specify the displayed ordinate range. You can click 
the ‘Autoscale’ button during the data collection to 
automatically scale the display. 

e Set the speed of the data collection by setting the ‘Ave. Time’ 
and ‘Data Interval’. The Data Interval is the wavelength 
increment between data points. The ‘Scan Rate’ will 
automatically update when selected. 

f Make sure that ‘Cycle Mode’ is not selected. 

3 Set up SBW, lamp and graphics options 

Setup dialog box | Options page 

a Set the ‘SBW’ (spectral bandwidth).  

b If you are using a Cary 100/300/5000/6000i, set the ‘SBW’ for 
the run. A good starting point is 2 nanometers if your method 
does not specify a SBW. 

c Set the ‘Beam Mode’ for the run (usually ‘Double’). 

d For Cary 5000/6000i, the fixed SBW is used to automatically 
alter the Energy level and maintain a constant signal level. 

e For Cary 4000/5000/6000i, set the ‘Slit Height’ to Full. 

f Click the UV/Vis button if you want both the lamps on during 
the run.  

g Select Auto Lamps Off if you want to automatically turn off 
the lamps at the end of a collect. This option is especially 
useful when performing Scan runs overnight or unattended 
for long periods of time.  

h Check Signal-to-Noise Mode, and set the required values for 
the Acceptable S/N and the S/N Timeout. 

i Under ‘Display Options’, select ‘Individual Data’ to display 
the collected data of each sample in individual graph boxes. 
Choose the ‘Overlay Data’ to superimpose the collected data 
of each sample in the Scan run in one graph box. 
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Setup dialog box | Independent page 

On the ‘Independent’ page, make sure ‘Independent Control’ is not 
selected. 

4 Set up the baseline correction 

Setup dialog box | Baseline page 

Select ‘Baseline Correction’ to perform a baseline correction on each 
sample data point. 

NOTE You can use a stored baseline by clicking ‘Baseline’ and opening the saved *.csw 
baseline file. 

 
5 Ensure no accessories are selected 

Setup dialog box | Accessories 1 page 

Make sure that no options are selected on this page and that no 
accessories are installed. 

Setup dialog box | Accessories 2 page 

Make sure that no options are selected on this page and that no 
accessories are installed. 

Setup dialog box | Accessories 3 page 

Make sure that no options are selected on this page and that no 
accessories are installed. 

6 Set up reporting and printing requirements 

Setup dialog box | Reports page 

a Enter your name in the ‘Name’ field.  

b Enter a comment relating to your experiment in the 
‘Comment’ field.  

c Set up your report style by selecting the appropriate check 
boxes under ‘Options’. For example, select ‘AutoPrint’ to 
automatically obtain a printout of your report. Select ‘Graph’ 
to include a graph in the generated report.  
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NOTE If ‘AutoPrint’ is selected, the system will send the report information to the 
specified printer as well as the Report area. 

 
d Set up the ‘Peak Table’ reporting.  

(i) Select Peak Labels.  

(ii) Click the Peak Information button and choose the ‘Peak 
Type’, the ‘Labels Type’, the and set the ‘Peak Threshold’. 
Click OK. 

(iii) Select Maximum Peak to report the peak with the largest 
peak threshold that exceeds the Peak Threshold value. 

(iv) Select All Peaks to report all peaks meeting the Peak 
Style criterion and exceeding the Threshold value. 

e Set up ‘X-Y pairs’ reporting, if required. You can use the 
actual Data Interval by which the data was collected or you 
can make the Cary interpolate the points to a new Interval. 

f Select the ‘Autoconvert’ option you require. If you select 
‘Select for ASCII (csv)’ or ‘Select for ASCII (csv) with Log’, at 
the end of the data collection the system will automatically 
generate a report and store the data in the Cary format as 
well as ASCII XY pairs format in the current folder. 

7 Set up storage of collected data 

Setup dialog box | Auto Store page 

Select Storage On (Prompt at End). 

8 Set up visual system monitoring 

Select Show Status Display on any Setup page, or from the View 
menu, to display information about your current reaction. 

9 Finish setup 

Once you are satisfied with your method setup, click OK to confirm 
any changes you have made and close the ‘Setup’ dialog box. 
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10 Zero the instrument 

Click Zero, or choose Zero from the Commands menu to perform a 
zero. 

11 Measure a baseline 

a Click Baseline or choose Baseline from the Commands 
menu.  

b When prompted, insert the blank sample into the sample 
compartment front beam and click OK. After the baseline is 
collected, the word ‘baseline’ will be displayed in red in the 
ordinate status box, indicating that you are in baseline 
correction mode and have a valid baseline file for the 
correction. 

NOTE If the word ‘baseline’ is gray and in italics, the baseline file is still valid. The gray 
and italics indicate that the Cary is idling outside the abscissa range of the 
baseline file. 

 
12 Start the run 

Click the Start button or choose Start from the Commands menu. 

13 Name your samples 

Once you click ‘Start’, the ‘Sample Name’ dialog box will be 
displayed. Enter the appropriate name for you sample and click OK. 
The Scan run will commence and the corrected trace will be 
displayed in the Graphics area. 

If for a particular point, the set Acceptable S/N cannot be met in the 
set ‘S/N Timeout’ time, the Cary will collect the point as normal 
(using the S/N Timeout as the Ave. Time) and display the message 
SNR Timeout in the hardware status area. 

14 Save your data 

When the Cary has measured the sample, the ‘Save As’ dialog box 
will be displayed. Enter the appropriate name for your sample and 
click Save. The Cary will then create the report and print it, if 
‘AutoPrint’ has been selected on the ‘Reports’ page of the ‘Setup’ 
dialog box. 
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Perform a scan in Independent mode (Cary 5000) 
This procedure describes how to perform a wavelength scan from 
2200 nm to 400 nm in Independent mode (Cary 5000 only). 

1 Set up data collection parameters 

Setup dialog box 

In Scan, click the Setup button or choose Setup from the Menu line 
to display the ‘Setup’ dialog box and specify the method parameters 
for a new method. 

2 Set up instrument parameters 

Setup dialog box | Cary page 

a Set the appropriate abscissa mode for the scan in the ‘X 
Mode’ field. 

b Set the wavelength range for the scan by entering the values 
you require in the ‘Start’ and ‘Stop’ fields. 

c In the ‘Y Mode’ field, select the ordinate mode. 

d Enter an upper and lower range in the ‘Y min.’ and ‘Y max.’ 
fields to specify the displayed ordinate range. You can use 
the ‘Autoscale’ button during the data collection to 
automatically scale the display. 

e Do not set any Scan Controls, such as ‘Ave. Time’ or ‘Data 
Interval’, as the settings in Independent mode will override 
these. 

f Make sure that ‘Cycle Mode’ is not selected. 

3 Set up SBW, lamp and graphics options 

Setup dialog box | Options page 

a Do not set the ‘SBW’ (spectral bandwidth) or Energy, as the 
settings in Independent mode will override these. 

b Set the ‘Beam Mode’ for the run (usually ‘Double’). 

c Set the ‘Slit Height’ to Full. 

d Click the UV/Vis button if you want both lamps on during the 
run.  
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e Select Auto Lamps Off if you want to automatically turn off 
the lamps at the end of a collect. This option is especially 
useful when performing Scan runs overnight or unattended 
for long periods of time.  

f Under ‘Display Options’, select ‘Individual Data’ to display 
the collected data of each sample in individual graph boxes. 
Choose ‘Overlay Data’ to superimpose the collected data of 
each sample in the Scan run in one graph box. 

4 Set up the signal level controls (SBW/energy) for the scan 

Setup dialog box | Independent page 

a Select Independent Control. 

b Select the Auto ‘Measurement Mode’. This will mean that the 
Cary will use a Fixed SBW (spectral bandwidth) in the UV-Vis 
region and a fixed Energy level in the near infra-red region. 

c Under ‘UV-Vis’, set the parameters you require in the UV-Vis 
region. Good starting values are: Ave. Time = 0.1, Data 
Interval = 1, Scan Rate = 600, SBW = 2. 

d Under ‘NIR’, set the parameters you require in the near infra-
red region. Good starting values are: Ave. Time = 0.1, Data 
Interval = 4, Scan Rate = 2400, Energy=1. 

5 Set up baseline correction 

Setup dialog box | Baseline page 

Select Baseline Correction to perform a baseline correction on each 
sample data point. 

NOTE You can use a stored baseline by clicking ‘Baseline’ and opening the saved *.csw 
baseline file. 

 
6 Ensure no accessories are selected 

Setup dialog box | Accessories 1 page 

Make sure that no options are selected on this page and that no 
accessories are installed. 
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Setup dialog box | Accessories 2 page 

Make sure that no options are selected on this page and that no 
accessories are installed. 

Setup dialog box | Accessories 3 page 

Make sure that no options are selected on this page and that no 
accessories are installed. 

7 Set up reporting and printing requirements 

Setup dialog box | Reports page 

a Enter your name in the ‘Name’ field. 

b Enter a comment relating to your experiment in the 
‘Comment’ field.  

c Set up your report style by selecting the appropriate check 
boxes under ‘Options’. For example, select ‘AutoPrint’ to 
automatically obtain a printout of your report. Select ‘Graph’ 
to include a graph in the generated report.  

NOTE If ‘AutoPrint’ is selected, the system will send the report information to the 
specified printer as well as the Report area. 

 
d Set up the ‘Peak Table’ reporting.  

(i) Select Peak Labels.  

(ii) Click the Peak Information button and choose the ‘Peak 
Type’, the ‘Labels Type’, and set the ‘Peak Threshold’. Click 
OK. 

(iii) Select Maximum Peak to report the peak with the largest 
peak threshold that exceeds the Peak Threshold value. 

(iv) Select All Peaks to report all peaks meeting the Peak 
Style criterion and exceeding the Threshold value. 

e Set up ‘X-Y pairs’ reporting, if required. You can use the 
actual Data Interval by which the data was collected or you 
can make the Cary interpolate the points to a new Interval. 
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f Select the ‘Autoconvert’ option you require. If you select 
‘Select for ASCII (csv)’ or ‘Select for ASCII (csv) with Log’, at 
the end of the data collection the system will automatically 
generate a report and store the data in the Cary format as 
well as ASCII XY pairs format in the current folder. 

8 Set up storage of collected data 

Setup dialog box | Auto Store page 

Select Storage On (Prompt at End).  

9 Set up visual system monitoring 

Select Show Status Display on any Setup page, or from the View 
menu, to display information about your current reaction. 

10 Finish setup 

Once you are satisfied with your method setup, click OK to confirm 
any changes you have made and close the ‘Setup’ dialog box. 

11 Zero the instrument 

Click Zero to zero the system. Alternatively, choose Zero from the 
Commands menu to perform a zero. 

12 Measure a baseline 

a Click Baseline or choose Baseline from the Commands 
menu.  

b When prompted, insert the blank sample into the sample 
compartment front beam and click OK. After the baseline is 
collected, the word ‘baseline’ will be displayed in red in the 
ordinate status box, indicating that you are in baseline 
correction mode and have a valid baseline file for the 
correction. 

NOTE If the word ’baseline’ is gray and in italics, the baseline file is still valid. The gray 
and italics indicate that the Cary is idling outside the abscissa range of the 
baseline file. 

 
13 Start the run 

Click the Start button or choose Start from the Commands menu.  
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14 Set up sample names 

When you click Start, the ‘Sample Name’ dialog box will be displayed. 
Enter the appropriate name for you sample and click OK. The Scan 
run will commence and the corrected trace will be displayed in the 
Graphics area. 

15 Save your data 

When the Cary has measured the sample, the ‘Save As’ dialog box 
will be displayed. Enter the appropriate name for your sample and 
click Save. The Cary will then create the report and print it, if 
‘AutoPrint’ was selected on the ‘Reports’ page of the ‘Setup’ dialog 
box. 

Scanning Kinetics 

Collect data using the Multicell Holder with temperature control  
This procedure demonstrates how to perform a multicell, multi-stage 
wavelength scan with baseline correction from 600 to 500 nm at 
37 °C using the Temperature Controller accessory with the Multicell 
Holder accessory (Cary 100/300/4000/5000/6000i). You can then use 
the data to create kinetics continuums in order to calculate reaction 
rates.  

1 Set up data collection parameters 

Setup dialog box 

In Scanning Kinetics, click the Setup button or choose Setup from 
the Menu line to display the ‘Setup’ dialog box and specify the 
method parameters for a new method. 

2 Select the baseline correction type 

Setup dialog box | Baseline page  

Select Baseline Correction. This will force the Cary to use a baseline 
scan to perform a baseline correction on the sample data. The 
correction will be performed on each point before it is displayed.  
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NOTE You can use a stored baseline. To do this, click the ‘Retrieve Baseline File’ button 
and open the saved *.csk baseline file. 

 
3 Set up the Multicell Holder accessory  

Setup dialog box | Accessories page  

a Ensure that you have the appropriate accessories installed 
before starting the run. 

b Select Use Cell Changer to enable the Multicell Holder 
accessory.  

c Choose the type of Multicell Holder you are using (6 x 6 or  
8 x 6).  

NOTE If you are using a Series I 6 x 6x (Cary 100/300), you must calibrate the cell 
changer using the Align application before starting experiments. 

 
d Click Select Cells and select the cells you require under ‘Use 

Cells’. 

For Front Beam analysis, select ‘Cell 1–Cell 6’ (6 x 6) or  
‘Cell 1–Cell 8’ (8 x 6). This will ensure that all front cell 
positions in the Multicell Holder will be measured during 
your Scanning Kinetics analysis. 

e Select Multi Zero.  

4 Set up accessories for reaction temperature control and 
temperature display 

a If you are not using a Peltier-controlled accessory (for 
example, the water-thermostatted 8 x 6), ensure that you 
have the Temperature Controller accessory installed before 
starting the run. 

b Select Automatic Temperature Setting and click 
Temperature Controller to enable the accessory. 
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c Set the monitoring temperature by entering the block 
temperature as 37 °C. (The monitoring device is selected in 
Step 6d.) 

d Under ‘Temperature Display’, select Block and Probe 1 to 
view the temperature of the Multicell Holder block and one 
temperature probe in the ‘Status Display’ window.  

5 Set up instrument parameters 

Setup dialog box | Cary page 

a Set the appropriate abscissa mode for the scan in the  
‘X Mode’ field. 

b Set the wavelength range for the scan by entering the values 
you require in the ‘Start’ and ‘Stop’ fields. 

c In the ‘Y Mode’ field, select the ordinate mode you require.  

d Enter an upper and lower range value for ‘Y min.’ and  
‘Y max.’ to specify the displayed ordinate range.  

e Set the speed of the data collection by setting the ‘Ave. Time’ 
and ‘Data Interval’. The Data Interval is the wavelength 
increment between data points. The ‘Scan Rate’ will 
automatically update when selected.  

6 Set up rate parameters   

Under ‘Collect Timing’, select Advanced Collect to set up different 
data collection procedures for the multiple rates in your reaction. 

NOTE The ‘Advanced Collect’ facility enables you to collect data more frequently during 
the crucial stages of your reaction, and to collect data less frequently where you 
know there will not be much activity. 

 
a Enter the number of different reaction rates that you require 

in the ‘Number of Stages’ field. The number you set here will 
be reflected in the table below. 

b Specify how long the Cary will wait after reading each cell 
before it starts another reading cycle by setting the ‘Cycle 
time’ for each rate stage. 
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c Specify the duration of the Scanning Kinetics run by setting 
the ‘Stop time’ for each rate stage. 

d Choose the desired temperature monitoring device in the 
‘Monitor’ field. The ‘Start’ button will not be enabled until the 
temperature of the selected monitor is within 0.5 °C of the 
block temperature set on the ‘Accessories’ page (Step 4c).  

7 Set up spectral bandwidth or energy and lamp options  

Setup dialog box | Options page  

a Set the ‘SBW’ (spectral bandwidth) for the run. 

b Set the ‘Slit Height’ to Full. 

c Select Auto Lamps Off if you want to automatically turn off 
the lamps at the end of a collect. This is especially useful 
when performing data collections overnight or unattended 
for long periods of time.  

d Click the UV/Vis button if you want both lamps on during the 
run.  

e Enter your required ‘Source Changeover’ wavelength in the 
corresponding field. If you are using a Cary 5000/6000i, also 
enter the detector and grating changeover wavelengths (800 
nanometers is recommended for both). 

8 Set up analysis parameters  

Setup dialog box | Analyze page 

This page is used for post-run calculations.  

9 Set up reporting and printing requirements  

Setup dialog box | Reports page  

a Enter your name in the ‘Name’ field. 

b Enter a comment relating to your experiment in the 
‘Comment’ field. 

c Set up your report style by selecting the appropriate check 
boxes under ‘Options’. For example, select ‘Auto Print’ to 
automatically obtain a printout of your report. Select ‘Graph’ 
to include a graph in the generated report.  
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NOTE If ‘Auto Print’ is selected, the system will send the report information to the 
specified printer as well as to the Report area. 

 
d Select Include X-Y Pairs Table to view a list of abscissa 

values and their corresponding ordinate values. 

e Select the ‘Autoconvert’ option you require.  

f If you choose ‘Select for ASCII (csv)’ or ‘Select for ASCII 
(csv) with Log’, at the end of the data collection the system 
will automatically generate a report and store the data in the 
Cary format as well as ASCII XY pairs format in the current 
folder. 

10 Set up storage of collected data  

Setup dialog box | Auto Store page  

Select Storage On (Prompt at Start), to set the Cary to prompt you 
for a file name before the start of the Scanning Kinetics run.  

11 Set up visual system monitoring  

Select Show Status Display on any of the Setup pages, or from the 
View menu, to display information about your current reaction. 

12 Finish setup  

Click OK to save any changes you have made and close the ‘Setup’ 
dialog box. Depending on the cells selected in the Multicell Holder, 
the Cary may then inform you that it will perform a dual single beam 
calibration. Click OK. 

13 Measure a baseline 

a If you do not have a valid baseline file, the Cary will prompt 
you to click Baseline to set up the baseline collection.  

b The system will display a ‘Cell Loading Guide’. If you like, 
change the name of the blank. 

c Insert blank samples into the cell changer to collect the 
0Abs/100%T baseline scans and click OK.  
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The system will set up the Graphics area and the Cary will collect the 
baseline scan. After the collection, the word ‘baseline’ will be 
displayed in red in the ordinate status box, indicating that you are in 
baseline correction mode and you have a valid baseline file for the 
correction. 

If you want to use the baseline again with other samples, save the 
method using ‘Save Method As’ on the ‘File’ menu. Then, when you 
re-open the method, the baseline will also open and be ready to use. 
It is preferable to save the baseline with the method, rather than a 
baseline file, as that way you can be sure that all your collection 
parameters are exactly the same for the new Scanning Kinetics runs. 
However, Good Laboratory Practice recommends that you collect a 
new baseline for each laboratory session. 

14 Zero the instrument  

a Click Zero or choose Zero from the Commands menu. 

b If you like, change the name of the blank/s. 

c Insert blank samples into the appropriate positions of the 
Multicell Holder and click OK.  

15 Start the run  

a Click the Start button to start a data collection. Alternatively 
you can choose Start from the Commands menu. Do not add 
your active reagent at this time.  

NOTE At this point, the system will display the ‘Save File’ dialog box if you have 
selected ‘Storage On (Prompt at Start)’ on the ‘Auto Store’ page of the ‘Setup’ 
dialog box. If so, enter the file name for this Scanning Kinetics run in the ‘File 
name’ field and click ‘Save’. 

 
b The system will display a ‘Cell Loading Guide’. If you like, 

change the names of the samples. 

c Place the sample solution(s) in the correct cell positions and 
click OK. The ‘Sync Start’ dialog box will be displayed. 

d Add your active reagent just before the countdown reaches 
0:00, or commence the data collection by clicking OK.  
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e At the end of the run, determine the actual Stop Time by 
observing the last value in the ‘Time’ column of the ‘User 
Data Form’. 

Perform a Simple Reads measurement at a single wavelength 
This procedure describes how to perform a Simple Reads 
measurement at a single wavelength. 

1 Set up instrument parameters (wavelength, Y mode)  

a In Simple Reads, click the Setup button or choose Setup 
from the Menu line to display the ‘Setup’ dialog box. 

b Select Read at Wavelength and enter the required 
wavelength. 

c Under ‘Y Mode’, select the ordinate mode you require. The 
ordinate mode determines the way in which the photometric 
value is measured and displayed in your report. 

d Click OK. The instrument will change to the new wavelength. 

2 Zero the instrument 

Make sure that the sample compartment is clear (or you have a blank 
in position) and click Zero. (Wait for the ordinate reading to reach 
‘0’.) 

3 Read the sample  

a Insert the sample into the sample compartment. Wait while 
the instrument changes to the specified wavelength. The 
current wavelength is displayed in the Abscissa status 
display at the top right of the application window. 

b Click the Read button to perform photometric measurements 
on the sample at the specified wavelength. The result appears 
in the Report area and includes the ordinate reading 
obtained and the wavelength at which the reading was 
measured.  

4 Print the results  

You can print the contents of the Report area by clicking the Print 
button. 
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Thermal 
The following Thermal procedures are described: 

 Performing a run and determine Tm using Derivative calculations  

 Performing a run and determine Tm using Hyperchromicity 
calculations  

Perform a run and determine Tm using derivative calculations  
This procedure describes how to perform a Thermal run using a 
single temperature rate and automatically calculate Tm from the first 
derivative. 

1 Set up data collection parameters 

Setup dialog box 

In Thermal, click the Setup button, or choose Setup from the Menu 
line to display the ‘Setup’ dialog box and specify the method 
parameters for a new method. 

2 Set up instrument parameters  

Setup dialog box | Cary page 

a In the ‘Wavelength’ field, enter the wavelength that you 
would like to monitor. 

b In the ‘SBW’ field, enter the required spectral bandwidth. 

c In the ‘Ave. (averaging) Time’ field enter the required value. 

NOTE For slow changes in temperature (that is, slow ramp rates), it is recommended 
that a long Ave. Time (for example, 2 to 3 seconds) be set. 

 
d Enter the ordinate values in the ‘Y min.’ and ‘Y max.’ fields. 

3 Set up rate parameters  

a Specify the ‘Collect Temperatures’ parameters: 

b In the ‘Start °C’ field, enter the temperature at which you 
want to start the data collection. 
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NOTE Once you click ‘OK’ to close the ‘Setup’ dialog box, the Cary will drive the 
temperature to the specified Start Temperature. 

 
c In the ‘Return °C’ field, enter the temperature to which you 

want the Temperature Controller to drive at the end of the 
data collection. 

d Use ‘Monitor’ to specify whether the temperature will be 
measured at the block or the probe. 

e Select Simple Collect to set a single rate of temperature 
change for the entire Thermal run. 

f Enter the ‘Data Interval’, ‘Ramp Rate’, ‘End Temperature’ 
and ‘Hold time’. Select the stages where you want to collect 
data in the ‘Collect Data’ column. 

4 Set up the lamp source operation and data display options 

Setup dialog box | Options page 

a Select Auto Lamps Off if you want to automatically turn off 
the lamps at the end of a collect. This is especially useful 
when performing collections overnight or unattended for 
long periods of time.  

b Click UV/Vis if you want both lamps on during the run.  

c Under ‘Display Options’, select ‘Individual Data’ to display 
the collected data of each sample in individual graph boxes. 
Select ‘Overlay Data’ to superimpose the collected data of 
each sample in the run in one graph box. 

5 Ensure no accessories are selected 

Setup dialog box | Accessories page 

Click the Accessories tab and make sure that no accessories are 
selected. 

6 Set up the analysis to reduce measurement interference 

Setup dialog box | Analyze page 

Select Smoothing and nominate the smoothing ‘Interval’ and ‘Filter 
Size’ to control the number of measurement points to be averaged. 
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7 Set up a derivative method of analysis 

a Select Derivative to calculate the temperature at which 50% 
of the DNA strands have separated (Tm). 

b Select Autocalculate to automatically perform a derivative 
calculation at the end of each run.  

NOTE You can manually perform the derivative calculation, once the run is complete. 

 
c Define the range over which to calculate and plot the first 

derivative of the selected scan.  

d Enter the Interval at which data is sampled in order to 
perform a derivative calculation. A derivative calculation 
involves the collection of points from a plot. Selection of 
these points is dependent upon the data interval chosen. The 
data points are then used to generate a separate trace from 
which a derivative calculation is performed. The selection of 
the Derivative Interval is dependent on the rate of data 
collection. If data is collected every 0.1 °C then a derivative 
interval of 0.1 °C will give the most accurate result. 

e Enter the Filter Size you require for the derivative 
calculation. The derivative uses a Savitzky Golay technique 
where a number of points surrounding an individual point 
are averaged to produce a new, smoothed point. For example, 
a five point derivation uses the two data points before and 
after each data point. 

NOTE The larger the filter size, the more data points that are included in the filter for 
smoothing. 

 
f Enter the temperature that you want to start the calculation 

in the ‘Low Calculation Limit’ field. 

g Enter the temperature where you want to end the calculation 
in the ‘High Calculation Limit’ field. 
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8 Set up other recalculations and normalization 

Setup dialog box | Reports page 

a Select Calculation and enter or select an equation in the field 
to perform a calculation. 

b Select Correction and enter the ‘Correction Temperature’ to 
perform a Thermal Expansion Correction. 

c Select Normalize and enter the temperature at which you 
would like the data to be normalized. 

9 Set up reporting and printing requirements 

a Enter your name in the ‘Name’ field.  

b Enter a comment relating to your experiment in the 
‘Comment’ field. 

c Set up your report style by selecting the appropriate items 
under ‘Options’. For example, select ‘Auto Print’ to 
automatically obtain a printout of your report. Select ‘Graph’ 
to include graphics in the generated report.  

NOTE If ‘Auto Print’ is selected, the system will send the report information to the 
specified printer as well as the Report area. 

 
d Select the ‘Autoconvert’ option you require. If you select 

‘ASCII’ or ‘ASCII with Log’, at the end of the data collection 
the system will automatically generate a report and store the 
data in the Cary format as well as ASCII XY pairs format in 
the current folder. 

10 Set up storage of collected data 

Setup dialog box | Auto Store page 

Select Storage Off. 

11 Set up visual system monitoring 

Select Show Status Display on any of the Setup pages, or from the 
View menu to display information about your current reaction. 
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12 Finish setup 

Once you are satisfied with your method setup, click OK to save any 
changes made and close the ‘Setup’ dialog box. The Cary will start to 
drive the temperature to the start temperature. 

13 Zero the instrument 

a Click Zero or choose Zero from the Commands menu. A 
‘Loading Guide’ will be displayed.  

b Place a blank solution in the cell that is in the light beam in 
sample compartment and click OK. The system will perform 
an instrument zero on the blank solution. 

14 Equilibrate the sample 

Make sure that the Cary has reached the start temperature and has 
been at this temperature for 2 to 3 minutes. If you entered a hold 
time in the ‘Stage 1 Hold’ field (Cary page), the system will wait and 
equilibrate at this temperature for the hold time before proceeding 
with the ramp. It is not necessary to wait to click the ‘Start’ button. 

15 Start the run  

a Click the Start button or choose Start from the Commands 
menu. The system will display a ‘Loading Guide’.  

b Load your sample into the front cell holder.  

c Enter the name of your sample then click OK. The Cary will 
wait for the specified hold time and then perform the run. 

16 After the run 

At the end of the run, depending on what you have set in previous 
steps, the ‘User Data Form’ may appear. If it does, fill in the 
appropriate entries in the columns provided for the sample and click 
OK. The calculation equation will be displayed in the report. 

Also, since ‘Autocalculate’ (under ‘Derivative’) was selected on the 
‘Analyze’ page of the ‘Setup’ dialog box, a derivative calculation will 
be performed at the end of the data collection.  

The sample under investigation, with corresponding Tm values, will 
be displayed in the Report area as well as parameters used to 
generate the selected data file, temperature profile, and the method 
used to contain the Tm value. 
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A plot will be displayed in the Graphics area indicating the original 
temperature data and a plot of the first derivative of the selected 
scan. The point at which the derivative plot peaks (that is, maximum 
or minimum gradient on the original plot) is reported as the Tm value 
and the original plot is marked with an arrow to indicate this point.  

To view a plot of the collected data, choose Graph from the View 
menu. 

17 Save your data  

a From the File menu choose Save Data As. 

b In the ‘Files of Type’ field, click Batch. 

c Enter the file name for this run in the ‘File name’ field. 

d Click Save.  

Perform a run and determine Tm using hyperchromicity calculations 
This procedure describes how to perform a Thermal run with 
multiple temperature ramps and determine Tm using a 
hyperchromicity calculation. 

1 Set up data collection parameters 

Setup dialog box 

In Thermal, click the Setup button or choose Setup from the Menu 
line to display the ‘Setup’ dialog box and specify the method 
parameters for a new method. 

2 Set up instrument parameters  

Setup dialog box | Cary page 

a In the ‘Wavelength’ field, enter the wavelength that you 
would like to monitor. 

b In the ‘SBW’ field, enter the required spectral bandwidth. 

c In the ‘Ave. (averaging) Time’ field, enter the required value. 

NOTE For slow changes in temperature (that is, slow ramp rates), it is recommended 
that a long Ave. Time (for example, 2 to 3 seconds) be set. 

d Enter the ordinate values in the ‘Y min.’ and ‘Y max.’ fields. 
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3 Set up the collect temperature parameters 

a In the ‘Start °C’ field, enter the temperature at which you 
want to start the data collection. 

NOTE Once you click ‘OK’ to close the ‘Setup’ dialog box, the Cary will drive the 
temperature to the specified Start Temperature. 

 
b In the ‘Return °C’ field, enter the temperature to which you 

want the Temperature Controller to drive at the end of the 
data collection. 

c Use ‘Monitor’ to specify whether the temperature will be 
measured at the block or at the probe. 

d Select Advanced Collect. 

e Enter the number of changes in temperature rate that you 
require in the ‘Number of Stages’ field. 

NOTE An increase or decrease in the temperature must be a separate stage. 

 
f Enter the ‘Data Interval’, ‘Ramp Rate’, ‘End Temperature’ 

and ‘Hold time’. Select the stages where you want to collect 
data in the ‘Collect Data’ column. 

4 Set up the lamp source operation and the data display options 

Setup dialog box | Options page 

a Select Auto Lamps Off if you want to automatically turn off 
the lamps at the end of a collect. This is especially useful 
when performing Thermal data collections overnight or 
unattended for long periods of time.  

b Click UV/Vis if you want both lamps on during the run.  

c Under ‘Display Options’, select ‘Individual Data’ to display 
the collected data of each sample in individual graph boxes. 
Or select ‘Overlay Data’ to superimpose the collected data of 
each sample in the run in one graph box. 
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5 Set up the Multicell Holder accessory 

Setup dialog box | Accessories page 

a Ensure that you have the Thermostattable 6 x 6 Multicell 
Holder accessory installed before starting the run. 

b Select Use Cell Changer to enable the accessory.  

c Click Select Cells, and select the cells you require from the 
available cells under ‘Use Cells’. 

d Select Multi Zero to turn on the ‘Multi Zero’ facility.  

e Clear Blank Correction. 

6 Set up temperature display 

Under ‘Temperature Display’, select Block and Probe 1 to turn on 
monitoring of the Multicell Holder block and one temperature probe. 

7 Set up the RBA accessory 

a Under ‘RBA’, select Use RBA.  

NOTE If you are using a Series I RBA, you must configure it using the Align application 
before starting any experiments. 

 
b Select either ‘Attenuation’ and enter the Abs value or select 

‘Position’ and enter the angle position.  

8 Set up the analysis to reduce measurement interference 

Setup dialog box | Analyze page 

Select Smoothing and nominate the smoothing ‘Interval’ and ‘Filter 
Size’ to control the number of measurement points to be averaged. 
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9 Set up your method of analysis 

a Select Hyperchromicity to calculate the temperature at 
which 50% of the DNA strands have separated (Tm). 

NOTE The hyperchromicity calculation is performed once the run is completed. 

 
b Select Van't Hoff Calculation to calculate a Van't Hoff plot 

(Ln(K(T)) vs 1000/T(deg K)) and activate the 
‘Hyperchromicity’ items. 

c Select ‘Self Complementary’ if the DNA molecule being 
analyzed consists of identical strands. Otherwise, select ‘Non 
Self Complementary’. 

d Enter the concentration in the ‘Total Conc of Strands’ field. 

e Enter the ‘Molecularity’ (that is, the number of strands) of 
the hybrid. For example, enter ‘2' if the DNA molecule being 
analyzed consists of two strands. 

f Select Δ G to perform Δ G (free energy) and K (equilibrium 
constant) calculations. 

g In the ‘Number of Temperatures’ field, specify the number of 
temperatures at which you would like to perform the Δ G and 
K calculations. The number set here is reflected in the 
‘Temperature’ table below this field. 

h Enter the required temperature in each cell of the 
‘Temperature’ table. 

10 Set up other recalculations and normalizations 

Setup dialog box | Calculations page 

a Select Calculation and enter or select an equation to perform 
a calculation. 

b Select Correction and enter the ‘Correction Temperature’ to 
perform a Thermal Expansion Correction. 

c Select Normalize and enter the temperature at which you 
would like the data to be normalized. 
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11 Set up your reporting and printing requirements 

Setup dialog box | Reports page 

a Enter your name in the ‘Name’ field.  

b Enter a comment relating to your experiment in the 
‘Comment’ field. 

c Set up your report style by selecting the appropriate items 
under ‘Options’. For example, select ‘Auto Print’ to 
automatically obtain a printout of your report. Select ‘Graph’ 
to include graphics in the generated report.  

NOTE If ‘Auto Print’ is selected, the system will send the report information to the 
specified printer as well as the Report area.. 

 
d Select the ‘Autoconvert’ option you require. If you select 

‘ASCII’ or ‘ASCII with Log’, at the end of the data collection 
the system will automatically generate a report and store the 
data in the Cary format as well as ASCII XY pairs format in 
the current folder. 

12 Set up storage of collected data 

Setup dialog box | Auto Store page 

Select Storage On (Prompt at End).  

13 Set up visual system monitoring 

Select Show Status Display on any of the Setup pages, or from the 
View menu, to display information about your current reaction. 

14 Finish setup 

Once you are satisfied with your method setup, click OK to save any 
changes made and close the ‘Setup’ dialog box. 

15 Zero the instrument 

a Click Zero or choose Zero from the Commands menu. The 
system will display a ‘Cell Loading Guide’.  

b Place the blank solutions in the correct positions in the 
holder then click OK to zero the specified cells. 
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16 Equilibrate the samples 

Ensure that the start temperature has been reached and held at this 
temperature for 2 to 3 minutes. If you entered a hold time in the 
‘Stage 1 Hold’ field (on the ‘Cary’ page), the system will wait and 
equilibrate at this temperature for the hold time before proceeding 
with the ramp, and it is not necessary to wait to click the ‘Start’ 
button. 

17 Start the run 

Click the Start button or choose Start from the Commands menu to 
start the Thermal run. The ‘Save As’ dialog box will be displayed. 

18 Set up file name and trace names for the data 

a Enter the appropriate name for your run and click Save. The 
system will display a ‘Cell Loading Guide’. 

b Place the solutions in the correct cell positions in the holder. 

c Enter the name of each sample in the corresponding field 
then click OK. 

The Cary will wait for the specified hold time and then perform the 
Thermal run. 

19 After the run 

At the end of the run, depending on what you have set in previous 
steps, the ‘User Data Form’ may appear. If it does, fill in the columns 
for each sample trace and click OK. The calculation equation will be 
displayed in the report. 

20 Hyperchromicity calculations 

The Cary WinUV software will now prompt you to use the Thermal 
ruler to define various limits for the hyperchromicity calculations. 

a A prompt will be displayed asking you to select the 
Associated DNA limits using the Ruler. Click OK. The cursor 
changes to ruler mode. 

b Position the mouse pointer on the Thermal curve at one end 
of the linear region of the Associated DNA part of the curve 
(before transition). Click and drag along the curve and 
release at the other end of the linear region. 
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The software will automatically calculate a linear least 
squares line between the selected points and extrapolate to 
both ends of the melting curve.  

c An ‘Associated DNA Limits’ dialog box will be displayed, 
displaying the upper and lower limits that you selected with 
the Thermal Ruler. Click OK to accept the calculated line.  

d A prompt will then appear asking you to select the 
‘Deassociated DNA limits’ using the Ruler. Click OK on this 
prompt. The cursor changes to ruler mode. 

e Position the mouse pointer on the Thermal curve at one end 
of the linear region of the Deassociated DNA part of the 
curve (after the transition). Click and drag along the curve 
and release at the other end of the linear region.  

The software will automatically calculate a linear least 
squares line between the selected points and extrapolate to 
both ends of the melting curve. 

f A ‘Deassociated DNA Limits’ dialog box will be displayed 
displaying the upper and lower limits that you selected with 
the ruler. Click OK to accept the calculated line.  

NOTE The Associated and Deassociated DNA Limits dialog boxes allow you to re-select 
your limits if you are not satisfied with the linear least squares lines drawn in the 
graph box. To do this, click ‘Retry’ and select another region. If you wish to exit 
from the calculation mode, click ‘Cancel’. The ruler trace is removed from the 
graph.  

The Linear Region Associated and Deassociated correction points are displayed 
in the Report area. 

 

NOTE If the two extrapolated lines cross at any point, a warning will be displayed. Click 
‘Cancel’ and repeat steps (a) to (f) above and re-select the linear regions. Click 
‘Ignore’ to proceed with the calculation using the regions you have selected. 
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Using the lines calculated in the previous steps, the software will 
automatically create a second graph box and display the calculated 
Alpha curve.  

g A prompt will be displayed asking you to select the range on 
the Alpha curve that will be used for the Tm calculation. Click 
OK to make your selection.  

h Position the mouse pointer on the alpha curve at one end of 
the linear region. Click and drag along the curve and release 
at the other end of the linear region. 

i An ‘Alpha Tm Limits’ dialog box will be displayed displaying 
the selected limits. Click ‘Retry’ to reselect the limits, if 
required. Click OK to accept the selected ranges. A linear 
least squares line is drawn between the selected points and 
the value of temperature where  = 0.5 is calculated to give 
the Tm value. (The Tm value is automatically reported in °C 
and K.) 

If you have chosen the Van't Hoff Calculation method to calculate 
Δ G and K: 

j Using the data calculated in Step (i) above, the system 
automatically creates a third graph box displaying a Van't 
Hoff plot. A prompt will be displayed asking you to select the 
required range on the Van't Hoff plot to calculate Δ G and K. 
Click OK.  

k Position the mouse pointer on the Van't Hoff curve at one end 
of the linear region. Click and drag along the curve and 
release at the other end of the linear region. 

l A ‘Van't Hoff Limits’ dialog box will also appear, displaying 
the upper and lower limits that you selected with the ruler. 
Click OK to accept the calculated line. Alternatively, click 
‘Retry’ to reselect the limits using the ruler.  

NOTE If there is an error in the Van't Hoff calculation, you will be prompted to reselect 
the linear region. 
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A linear least squares line is calculated between these points and is 
extrapolated to both ends of the Van't Hoff plot. The slope and 
intercept of the calculated line gives the enthalpy and entropy of the 
hybrid formation (Δ H° and Δ S° respectively). 

The software will automatically send the results, using the calculated 
alpha curve, to the Report area including: 

 K(Tm)experimental 

 K(Tm)from first principles 

 K(T Tm)experimental/K(Tm)from first principles 

21 Step 20 will be repeated for each sample trace measured. 

Set up tests for validation 
The Validate application enables you to carry out a number of 
performance tests to verify that the system is performing according 
to specification. This procedure describes how to set up your 
instrument to perform a validation test. 

1 Set up test parameters 

a In the Validate application, click the Tests menu or the Tests 
button to display the ‘Configure’ page.  

b Select the type of instrument performance tests that you 
require. The various tests that are available will be displayed 
as tabs across the top of this dialog box. 

NOTE If your access privileges are restricted by the GLP application, you may find that 
fields and buttons in this dialog box are not accessible. 

 
c Click each tab and select the tests you require to be 

performed.  

d For each test, change any parameters that you require to be 
changed to suit your laboratory.  
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NOTE If you wish to save the tests you have set up for future use, choose ‘Save 
Method As’ from the ‘File’ menu to display the ‘Save As’ dialog box and save the 
method (with the file name extension ‘*.mvo’). 

 
2 Set up automated runs 

If you are using either the Multicell Holder or the Auto Double 
Aperture accessory to automate the testing procedure:  

a Click Setup to display the ‘Setup’ dialog box. 

b Click the Analyze tab. 

c Select the appropriate accessory.  

NOTE Check with your local Agilent office regarding the availability of this accessory. 

 
3 Start the run 

a Click the Start button or click Start on the Commands menu 
to commence the testing procedure. 

b If you set up for an automated run with the Multicell Holder 
in the previous step, then the ‘Cell Loading Guide’ will be 
displayed. Place the specified solutions and/or filters exactly 
as shown in this dialog box and click OK. 

Alternatively, follow the instructions on the prompts that 
appear and click OK to continue with the performance tests.  

Click Cancel at any time to stop the Validate run. 
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NOTE For manual runs (without the use of automated accessories), the Validate 
application will automatically arrange the tests so that tests requiring your 
intervention (for example, placing filters or solutions into the sample 
compartment) are performed early in the Validate run. Tests that do not require 
your intervention will be performed later in the run. The system will advise you 
when you are no longer required. However, if you require, you can change the 
order of the tests. 

 

The results for each test are displayed in the Report area 
immediately after the test is completed. 

4 After the run 

At the end of the Validate run, the Cary system automatically 
generates a report file. The report file is stored in the Cary WinUV 
directory.  

The Report file will be saved with the following format: 

DATE TIME.RVO 

For example: 

16 Apr 97 3;57;48 PM.RVO 

The date and time will be displayed in the same form that is set in 
the Windows Regional Settings Properties dialog box, accessed from 
the Windows Control Panel. 

NOTE At the end of the Validate run, you can also save your data. To do this, choose 
‘Save Data As’ from the ‘File’ menu to display the ‘Save As’ dialog box and save 
the current method, data and report in a batch file (BVO). 
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5. Troubleshooting 
Instrument offline 106 
Connect button instead of Start 106 
Not enough memory  107 
Poor display of videos and photographs  107 
GLP log does not list some privilege changes 108 
Report header and footer not being updated  108 

 

If you are having problems with your software, check the information 
in this chapter to see if there is a solution to your problem. You may 
also find a solution to your problem in the: 

 ‘Troubleshooting’ section in the hardware manual supplied with 
the instrument. 

 ‘Troubleshooting’ section of the Help. To view this, click the 
Windows ‘Start’ button, then ‘(All) Programs’, ‘Cary WinUV’, and 
‘Cary Help’. Click ‘Troubleshooting’ and follow the links. 

 Late Breaking News documents that were shipped with the Cary 
WinUV software. 

If you still have not found the solution to your problem, contact your 
local Agilent office or representative. 
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Instrument offline 
Problem 

When I start the Cary WinUV software, the application reports that 
the instrument is ‘Offline’. 

Solutions 

 Check the connection of the main instrument cable (IEEE cable) 
attaching the computer to the instrument. 

 Ensure the instrument has completed its initialization tests 
before you start the Cary WinUV software.  

 Contact your local Agilent office. 

For more information, refer to Chapter 4 in the Hardware manual 
provided with the instrument. 

Connect button instead of Start 
Problem 

When I start the Cary WinUV application, I want to use the ‘Start’ 
button but it has changed to a ‘Connect’ button — why? 

Solution 

When you first start the Cary WinUV software, the System 
Information application has control of the instrument while it 
initializes. Until the initialization has finished, any other application 
that you start will not have control of the instrument; hence the 
‘Connect’ button. Wait until the ‘Connect’ button changes to ‘Start’. If 
it does not change, check to see if you have any other Cary 
applications running. If they are not collecting data, you can just 
click the ‘Connect’ button to get control of the instrument. 
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Not enough memory 
Problem 

After installing version 3 of the Cary WinUV software, I get an error 
saying that there is not enough memory and the Cary WinUV 
software will not run. 

Solution 

Check that you have version 6.0 or later of Microsoft Internet 
Explorer installed. (To check the version, start Internet Explorer and 
choose ‘About Internet Explorer’ from the ‘Help’ menu. The version 
number will be displayed). 

Poor display of videos and photographs 
Problem 

The graphics and video display appears fuzzy, grainy or in weird 
colors. 

Solution 

Increase your display settings to a higher resolution.  

To do this: 

1 Click the Windows Start button then (Settings), Control Panel 
and double-click Display. 

2 Click the Settings tab and adjust the color quality and screen 
resolution to a higher setting (that is, 16 bit or 32 bit color), 
providing your monitor and display adapter allow it. 

3 Click OK. 

NOTE You may have to restart your computer for the settings to take effect. 
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GLP log does not list some privilege changes 
Problem 

I have changed multiple privileges using the GLP application, but not 
all of them appear in the log file that the application creates. What 
has happened? 

Solution 

You need to click the ‘Apply changes now’ button on the ‘Privileges’ 
page each time you change privileges for a user or application. You 
cannot make multiple changes and then click the ‘Apply Changes 
now’ button — the changes are actually made but they don’t appear in 
the log. 

Report header and footer not being updated 
Problem 

I have changed the report header and footer information in the 
System Information application, but it is not being updated when I 
generate a report — why? 

Solution 

You need to be logged on as an Administrator to make the changes in 
System Information. 
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